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Melacak Si Iseng

engan Snort kita dengan mudah dapat
mengenali ‘si iseng’ yang coba-coba men-
scan komputer kita (apa maunya ya?)

dengan melihat IP Address mesin ‘si iseng’ pada
alert log-nya Snort.

Dari IP Address itu dengan mudah kita bisa da-
patkan lokasi komputer ‘si iseng’ dengan trace-
route yang merupakan salah satu tool footprint-
ing (dibahas di NeoTek Vol. II No. 3)

Kali ini dikemukakan dua tool traceroute grafis,
yaitu NeoTrace dan VisualRoute (dapatkan di CD
NeoTek). Dengan NeoTrace, cukup ketikkan IP
Address ‘si iseng’ dan klik Go, maka akan ditam-
pilkan di mana secara geografis mesin yang me-
lakukan scanning tadi dan di mana hosting-nya.

Pada contoh ini karena komputer yang men-scan
dan kena scan sama-sama di Singapore maka
yang tampak adalah peta Singapore itu saja.

Nah!

Mau sembunyi kemana
kamu penyusup?

DD

NeoTrace dapat juga
digunakan untuk mencari lokasi

geografis suatu server dari URL-nya.
Pada contoh ini kita mencari

di mana server situs harian kompas
(www.kompas.com) terletak.

Cukup ketikkan www.kompas.com
pada kolol isian Target dan klik Go;

NeoTrace akan menampilkan
secara grafis perjalanan paket data
dari komputer kita sampai ke server
harian ini, yang ternyata di-hosting

di Houston, Texas.
Selain map view, terdapat pula 

list view dan node view

KKulacak Kauulacak Kau
sampai ksampai ke ‘ujung dunia’e ‘ujung dunia’
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Pendamping Berselancar Salam!Salam!

assword cracking dapat anda gunakan ketika suatu
saat anda lupa kata sandi yang pernah anda
masukkan di komputer. Dengan password cracking,

anda dapat ‘memancing’ kembali kata sandi yang terlupakan
itu dan mendapatkannya kembali. Password cracking, dengan
demikian, dapat membantu anda untuk menembus kebuntuan
yang terjadi karena terlupakannya kata sandi pada komputer.
Anda, dengan kata lain, tidak menjadi sewot.

NeoTek nomor ini menyajikan seluk beluk cara menembus
password pada komputer lengkap dengan perangkat atau
utilitas yang anda butuhkan untuk melakukan hal itu. Dan
kami, seperti biasa, menyajikan perangkat itu di CD bulan ini.

Redaksi
rreeddaakkssii@@nneeootteekk..ccoo..iidd

Belajar menembus passwordBelajar menembus password
agar tidak menjadi sewot.agar tidak menjadi sewot.

PP

• Cain & Abel disebutkan oleh pembuatnya sebagai ‘password recovery utility.’ Utilitas ini
dapat anda gunakan untuk memperoleh kembali kata sandi komputer yang anda lupa.

NeoTek menyediakan CD
yang berisi program-
program yang dibahas
pada NeoTek nomor ini:

• ScreenSaver Crack
• 007PwRec
• Dripper20
• PWLCrack
• L0phtcrack
• NTPassword
• WindowsCrack
• ExcelCrack
• Jigsaws Galore
• Paintshop Pro 7
• Psychostats
• NetBuster

Dapatkan CD-ROM-nya
dalam satu paket dengan
majalah NeoTek:

Majalah + CD Rp19.500
CD saja Rp15.000

Hubungi
Bagian Sirkulasi
Majalah NeoTek
Tel.   (021) 548 1457
Faks. (021) 532 9041

email:
pemasaran@neotek.co.id
Kontak: Elvi R. Nainggolan

www.neotek.co.id

Bagaimana menghubungi NNEEOOTEK?TEK?
KONTRIBUSI ARTIKEL
redaksi@neotek.co.id

SURAT PEMBACA
support@neotek.co.id

WEBMASTER
webmaster@neotek.co.id

PEMASARAN
pemasaran@neotek.co.id

CHATROOM DI DALNET
#neoteker

ADMINISTRASI IKLAN
Tel. 021-5481457 Fax. 021-5329041

SIRKULASI NEOTEK
Tel. 021-3854764

ALAMAT REDAKSI
Gedung Cahaya Palmerah Suite 506
Jl. Palmerah Utara III No. 9
Jakarta 11480

MILIS PARA NEOTEKER
http://groups.yahoo.com/group/majalahneotek

PENAWARAN KHUSUS
Dapatkan koleksi 8 CD NeoTek

- CD NEOTEK 2-1
- CD NEOTEK 2-2
- CD NEOTEK 2-3
- CD NEOTEK 2-4
- CD NEOTEK 2-5
- CD NEOTEK 2-6
- CD NEOTEK 2-7
- CD NEOTEK 2-8

Dengan harga Rp95.000,-
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Daftar IsiDaftar Isi
NeoStartNeoStart

NeoTNeoTek Vek Vol. Iol. I I No. 1I No. 122

Nge-crack Password
Bagaimana menembus alat
pengaman utama komputer?

7 Pasangan Pencuri
Dalam password cracking,
Cain dan Abel adalah

pasangan pencuri yang ampuh.

12

Screen Saver Password
Kata sandi ‘screen saver’ pun
dapat di-crack lewat segmen

pada registry.

8

Perulangan JavaScript
Perulangan digunakan untuk
mengefisienkan penulisan

program pada JavaScript.

26

Polling dengan ASP
Bagaimana membuat polling di
situs Web anda dengan

menggunakan ASP?

28

Password OE
Anda dapat menggunakan registry editor
untuk membongkar password OE.

22

Kendali Remote
Cain juga dapat berfungsi seba-
gai Abel Client, pengendali kom-

puter yang telah terpasang Abel.

BO & Deep BO
Cara mudah hacking dengan
menggunakan trojan legendaris

dari Cult of the Dead Cow.

14

33

Password Winzip
Advanced Archive Password
Recovery dapat digunakan

untuk memulihkan password Winzip.

20

Advanced Office 2000
Utilitas yang dapat digunakan
untuk memancing kembali

password pada program Microsoft
Office.

18

LOphtcrack untuk NT
Gunakan LOphtcrack untuk
membuka password pada

komputer dengan sistem operasi
Windows NT.

16

Password Revealer
Kenali utilitas-utilitas yang dapat
dengan mudah dapat memun-

culkan password yang terlupa.

9

Cracker untuk NT
Untuk Windows NT anda, di
antaranya, dapat menggunakan

LOphtcrack sebagai password cracker.

11

BO2K Client Mengen-
dalikan BO2K Server
Sekali suatu komputer ter-

infeksi BO2K Server, maka menjadi
bulan-bulanan pengendalinya yaitu
BO2K Client.

38

Konfigurasi BO2K
BO2K mewarisi fitur-fitur BO
plus kemampuannya untuk

dikonfigurasi dengan sangat fleksibel.

36

BO Peep
Ketangguhan BO2K ditambah
dengan banyaknya plug-in.

Salah satunya adalah BO Peep untuk
mengintip melalui video streaming.

40

NetBuster
Hati-hati hacking dengan trojan
NetBus. Bisa-bisa anda sendiri

yang kena hack.

42

BlackICE Defender
Suatu network-based IDS yang
mudah digunakan. Lebih dari

sekedar firewall.

45

Daftar Isi

NeoSoft

RealProfil

Situs NeoTek NeoTek Oktober 2002

Remote Password Cracking
Setelah memahami cara meng-crack
password secara offline, kita teruskan
dengan meng-crack password HTTP,
POP3, dan FTP secara online.

PHP dan PostNuke
Bersamaan dengan berakhirnya tutorial
JavaScript, NeoTek memulai tutorial
PHP serta instalasi server PostNuke.

Arabic Word Processor
MS Arabic keyboard mapping cocok
untuk keyboard asli Arabic. Tetapi
bagaimana menggunakan keyboard
Latin untuk Arabic word processing.

www.neotek.co.id
neotek.kpone.com.sg

Jadikan situs NeoTek sebagai pangkalan Anda berselancar

Link Langsung
Kunjungi situs-situs yang dibahas di
majalah NeoTek dengan sekali klik
lewat situs NeoTek.

NeoTek versi PDF
Kehabisan NeoTek di kota Anda?
Dapatkan saja versi PDF-nya. Gratis!

Download
Tersedia juga download di situs
NeoTek selain dari situs aslinya

Layanan Rupa-rupa NeoTek
Dapatkan perlengkapan awal dalam
berinternet dari situs web NeoTek
HumanClick
Hotline langsung ke redaksi NeoTek
untuk menyampaikan saran dan pesan.
Chat Room
Kini tidak usah jauh-jauh untuk ngobrol
langsung dengan sesama NeoTeker
Mailing List
Ini yang paling ramai. Segera ikutan
berbagi pengalaman berinternet!

NeoTrace0

Kru NeoTek
Bermarkas di
Gedung Cahaya Palmerah 503
Jl. Palmerah Utara III No. 9
Jakarta 11480
Telp. 021-5481457
Fax. 021-5329041

Bank
Bank BNI
a.n. PT NeoTek Maju Mandiri
No. rekening 070.001709720.001

Bank BCA KCP Rawamangun
a.n. Aswan Bakri
No. rekening 0940544131

Pemimpin Umum
Fachri Said

Pemimpin Redaksi
Kosasih Iskandarsjah

Redaktur Ahli
Onno W. Purbo
Michael S. Sunggiardi

Pemimpin Usaha
Fahmi Oemar
Ridwan Fachri

Redaktur Pelaksana
Gianto Widianto
Dadi Pakar

Sekretaris Redaksi
Elvy Risma Nainggolan

Dewan Redaksi
David Sugianto
Stanley

Webmaster
Supriyanto

Pemasaran
Hedhi Sabaruddin
Tuti Sundari

Iklan dan Promosi
Stanley
Elvy Risma Nainggolan

Keuangan
Aswan Bakri

3

6

4

5

Merunut paket data dari
satu mesin ke mesin lain
dalam LAN dan/atau
Internet. Semuanya secara
grafis!

NmN
Neoteker menjawab Neoteker
dalam forum milis NeoTek

Ada Apa di CD NeoTek?
PC Security
Enkripsi Menjaga Privasi Anda
Terdeteksi Sebagai Virus

Daftar Isi CD NeoTek

NeoRagam

Inbox
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FOKUS BULAN INIFOKUS BULAN INI Password Cracking:
Seni dan Tekniknya
Password Cracking:
Seni dan Tekniknya

NeoTNeoTeknoekno NeoTNeoTutorutor

Psychostats
Begitu populernya Counter
Strike sehingga banyak sekali

situs pendukungnya. Psychostats ada-
lah dukungan statistik untuk game
multi-user melalui Internet ini. Jangan
anggap remeh dengan game. Anda
perlu paham Perl, PHP, dan scripting.

NeoGameNeoGame
46

Puzzle Elektronik
Obat bete yang ampuh dan
mudah digunakan. Anda

dapat memanfaatkan foto pribadi atau
si dia untuk dijadikan puzzle.

48
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daftar isi cd neotekdaftar isi cd neotek
SCRIPTING & SERVER
JavaScript Editor 2.5 jse2em
PWS (web server) setup
ASP Edit aspedit
PHPEasy Windows Installer php404
PHPEdit phpedsetup3x
PHPTriad phptriadsetup2-11
Psychostats 1.8 psychostats1.8

TROJAN & ANTI TROJAN
Back Orifice (trojan) bo
Back Orifice 2000 (trojan) bo2k_1_0_full
NetBus 1.70 (trojan) netbus170
SubSeven s7a
BO Peep alt_bopeep_1-0
BO ButtTrumpet 2000 srv_bt2k_1-2
BO Cast 256 Encryption enc_cast-2.3
BO Rattler srv_rattler_1-10
BO Serpent Encryption enc_serpent-1.4
BO STCPIO io_stcpio_2-10
BO Tool cli_botool_1-10
Deep BO deepBO
NetBuster 1.31 netbuster1_31

NETWORK-BASED IDS FOR WINDOWS
AntiSniff1021 as-1021
BlackIce Defender 3.0 defeval
Snort 1.7 Windows snort-1.7-win32-static
Snort 1.8.3 Windows snort_1.8.3_win32_release
Win PCap WinPcap_2_3
IDS Center 1.08 idscenter

GAME
Jigsaws Galore 4.2 jigsawgalore42

NEOSOFT
NeoTrace NeoTraceProTrial325
Visual Route vr
Word 97 Quick Start setup

PROGRAM UMUM BERSELANCAR
Acrobat Reader ar500enu
CuteFTP cuteftp
GoZilla gozilla
ICQ icq2000b
Internet Explorer 6 ie6setup
mIRC mirc591t
Quick Time QuickTimeInstaller
RealPlayer rp8-standard-setup
WinAmp winampful
Windows Media Player mp71
WinZip wzbeta32
PaintShop Pro 7 PaintShopPro7_04
WS FTP ws_ftple

DICTIONARY
Dictionary
Dictionary Generator
Dictionary Creator
Dictionary Maker
PassList Generator
PassWord Dictionary
WordList

BIOS PASSWORD CRACKER
AMIBIOSCracker ami-crack
AMIBIOSDecoder amidecod
KillCMOS killcmos

SCREEN SAVER PASSWORD CRACKER
ScreenSaverCrack 95sscrk

CACHED PASSWORD REVEALER
007PwRec PasswordRecovery
DialUpRipper dialrip
Dripper20 dripper2.0
DUNRipper dripper
Rev Rev
RevelationNTPwCrack revelation_1_1
Showin20 showin
Snadboy_Revelation RevelationV2
Unhide unhide

PWL FILE CRACKER
DeelamPwLeecher depl
pwdump2 pwdump2
pwdump2orig pwdump2-orig
PWDumpUsewithNTCrack pwdump
PWLCrack Pwlcrack
PwlHack3.20 pwlhck32.rar
PwlHack402 pwl_h402.rar
Pwlhack410 pwl_h410.rar
Pwltool pwltool
Pwlview pwlview
MakePWL makepwl

NT PASSWORD CRACKER
L0phtCrack10 l0hptcrak
L0phtCrackNT lc201src
L0phtCrack 2.01 lc201.exe
L0phtCrack 3.0 lc3setup
Lc3 lc3setup02
L0phtCrack15 lc15.exe
NTCrack ntcrack20
NTPassword ntpsw
NTSweep ntsweep
NTUCrack NT ntucrack

APPLICATION PASSWORD CRACKER
Adv Mailbox Pw Rec ambpr
ao20pr ao20pr_s
Archpr21 archpr
ARJCracker breakarj
ARJHack arjcrack
BrkArj brkarj10
CrackEudora CrackPk18
Elcomsoft_AZPR azpr
EudoraPwDecoder eudpass
ExcelCrack excelcrack
GlideBFPwl glide
HotmailHack hotmhack
WindowsCrack windows_crack
WindowsPwCracker windows_passwd
WordDecrypt wwprt11d
WPCrack wpcrackb

PASSWORD STEALING TROJAN
Cain20 cain20
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AdaAda ApaApa didi CCDD NeoTNeoTek?ek?
Fokus NeoTek bulan ini adalah pada password cracking, khususnya untuk
memahami local security dan memulihkan password milik anda sendiri
yang terlupa. Namun dibahas juga Cain 2.0, suatu password stealing trojan.

CCDD  NNeeooTTeekk
SSeepptteemmbbeerr  22000022

assword adalah
teknik pengaman-
an yang paling

lazim digunakan.
Kelehaman password sa-
lah seorang user dalam
jaringan dapat dijadikan
batu pijakan untuk
hacking lebih lanjut ke
dalam jaringan.
NeoTek kali ini membahas
bagaimana segala macam
password pada dasarnya
dapat di-crack. Pertanya-
annya tinggal seberapa
sulit atau seberapa
mudah?
Enkripsi password bukan
berarti password tidak da-
pat di-crack, melainkan
membuat proses cracking
menjadi begitu lama se-
hingga tidak menarik lagi
untuk dilakukan.
Selain itu pada CD NeoTek
disediakan pula berbagai
macam kamus dan word
generator untuk kegiatan
password attack maupun
brute force attack. Uji pass-
word anda sendiri sebelum
‘diuji’ orang lain.
Khusus untuk scripting,
selain bahasan konvensio-
nal mengenai ASP dan
JavaScipt, terdapat juga
Psychostats, suatu pendu-
kung statistik untuk game
Counter Strike. Anda ha-
rus memahami Perl dan
PHP untuk dapat meman-
faatkannya.

1. BIOS Password
AMI BIOS Cracker
AMI BIOS Decoder
Kill CMOS

Password BIOS dapat diatasi
dengan mengangkat baterai
komputer atau dengan BIOS
password decoder

2. Screen Saver Pw.
Screen Saver Crack

Perlindungan berikutnya ada-
lah screen saver password
yang dapat pula diatasi de-
ngan Screen Saver Password
Recovery.
3. Cached Password

007 Password Recovery
DialUp Ripper
Dripper 2.0
DUNRipper
Rev
Revelation NT PW Crack
Showin 2.0
Snadboy’s Revelation
Unhide

Menyimpan password di
komputer memang berba-
haya sebab dapat diintip de-
ngan tool-tool di atas.

4. PWL Cracker
Deelam PwLeecher
PWDump2
PWDump2 Original
PWDump for NT
PWL Crack
PWL Hack 3.20
PWL Hack 4.02
PWL Hack 4.10
PWL Tool
PWL View
Make PWL

Windows menyimpan pass-
word dalam file PWL yang
dapat anda copy ke disket dan
tenang-tenang meng-crack-
nya di rumah.

5. NT Password
L0phtcrack 1.0
L0phtcrack 2.01 Src
L0phtcrack 2.01
L0phtcrack 3.0
L0phtcrack 3.0 v 02
L0phtcrack 1.5
NT Crack
NT Password
NT Sweep
NTU Crack NT

Dibandingkan dengan Linux,
NT Pasword lebih mudah di-

crack sebab tidak membeda-
kan huruf besar dan huruf
kecil serta password hash-
nya lebih pendek sebab di-
usahakan backward
compatible.

6. Application Pw.
Advanced Office 2000
Advanced Archive
ARJ Cracker
ARJ Hack
Break ARJ
Crack Eudora
Advanced Zip
Eudora Pw Decoder
Excel Crack
Glide Brute Force
Hotmail Hack
Windows Crack
Windows Pw Cracker
Word Decrypt
WP Crack

What do you want to crack
today? Segala macam pass-
word dapat di-crack.

7. Pw. Stealing Trojan
Cain 2.0

Selain mencuri password,
Cain juga berperan sebagai
remote admin trojan.

PP

PPAASSSWSWOORRD CD CRRAACCKKIINNGG

elanjutkan bahasan ten-
tang infeksi digital, kali

ini NeoTek kembali membahas
beberapa trojan yang terkenal:

Back Orifice
Trojan legendaris dari Cult of
the Dead Cow.

Deep Back Orifice
BO Client yang memanfaat-
kan BO Server dari BO yang
asli pada port yang berbeda.

Back Orifice 2000
Mewarisi ketangguhan BO
plus kemudahan konfigurasi
server maun client-nya.

BO Peep
Plugin BO2K yang mampu
memonitor server dengan
streaming video.

BO Butt Trumpet 2000
BO Cast-256 Encryption
BO Rattler
BO Serpent Encryption
BO STCPIO
BO Tool

Macam-macam plugin BO
yang sebagian besar dari
pihak ketiga.

NetBus 1.70
SubSeven

Remote access trojan yang
tidak kalah ganas dibanding-
kan Back Orifice.

NetBuster 1.31
Jebakan untuk pemakai
Netbus sehingga dapat
kena counter-hack.

TTRROJOJAN DAN DAN ANAN ANTTI-I-TTRROJOJANAN

MM
Terdeteksi Sebagai Virus
Pada CD NeoTek kali ini ada
beberapa program yang akan
terdeteksi sebagai virus.
TTrroojjaann  ddaann  AAnnttii--TTrroojjaann
• bo.exe
• bo2k_1_0-full.exe
• NetBus170.zip
• s7a.zip
• alt_bopeep_1-0.zip
• srv_bt2k_1_2.zip
• enc_cast_2.3.zip
• srv_rattler_1-10.zip
• enc_serpent-1.4.zip
• io_stcpio_2-10.zip
• cli_botool_1-10.zip
• deepBO.zip
• netbuster1_31.zip
PPaasssswwoorrdd  SStteeaalliinngg  TTrroojjaann
• cain20.exe

icrosoft Word merupakan alat bantu kerja sehari-hari
yang paling lazim. Namun masih banyak yang belum

memahami keseluruhan fungsinya. Dalam CD NeoTek kali ini
terdapat tutorial interaktif lengkap tentang Microsoft Word 97.

MM
Microsoft Word 97 Quick Start
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Inbox

Forum ini dimaksudkan sebagai bentuk offline dari mailing list
NeoTek di http://groups.yahoo.com/group/majalahneotek.

NmNNmN
NeoTeker menjawab NeoTekerNeoTeker menjawab NeoTeker

Aman IE atau Netscape?
T: Posted July 21
Mau tanya untuk versi yang
sekelas-artinya untuk tahun
releasenya sama misalnmya
ie.50 dengan netscape 4.75-
aman mana ie dengan
netscape. juga untuk versi
sekelas apakah eudora lebih
aman drpada outlook express

Apakah ada site untuk
online scaner gratis selain
di trendmicro.com (house
call antivirus)

Devi RQ
devi_rq@yahoo.com

J: Posted July 21
Pengalaman saya dulu,Nets-
cape Messager (CMIIW, po-
koke ada dalam paket Nets-
cape Communicator) lebih
aman dibanding produknya
MS (baik Outlook Express
maupun MS Outlook) da-
lam masalah daya tahan ter-
hadap virus. Tapi saat ini, ka-
yaknya Netscape Massager
udah mulai rentan juga
kok... CMIIW.

Bagi saya, selama antivirus
yg terpasang selalu uptodate
virus definitions-nya, Out-
look Express maupun MS
Outlook-pun sudah cukup
kebal thd serangan2 virus.
Oleh karenanya, sering2lah
meng-update virus definitions

Btw, Netscape Messager
versi berapa yag yg udah
bisa multi eMail account ???
AFAIK mulai versi 6.0 seh...
Ada yg pernah make ???

Mat Gemboel
gemboel@ToughGuy.net

J: Posted July 21
Balasan email untuk Mat
Gemboel. Kayaknya keren-
tanan suatu s/w atau OS sa-
ngat tergantung dari jumlah
pemakai s/w bersangkutan,

bila jumlahnya banyak maka
secara otomatis para cracker/
hacker akan berusaha men-
cari kelemahan s/w atau OS
tersebut untuk membuat
bencana yang lebih besar...

Cock Wirawan
dekock@dps.centrin.net.id

Tutorial VPN
T: Posted July 17
Ada neotekker yg bisa nga-
sih tutorial singkat tentang
implementasi VPN? dan ada
yg bisa ngasih referensi yg
bagus soal VPN ditunggu
jawabannya yaa

Rony Adriyanto
ronnie@pertamina.co.id

J: Posted July 18
VPN intinya adalah mem-
bentuk jaringan pribadi (pri-
vate network) dengan me-
manfaatkan jaringan public
(misalnya Internet). Itu se-
babnya disebut "Virtual".
Tujuan utama adalah mene-
kan biaya seminimal mungkin,
tanpa menghilangkan ke-
amanan/security.

Perbedaan PN (Private Net-
work) dan VPN (Virtual
Private Network) kurang
lebih sbb:

Private Network (Contoh A)

LAN di Jakarta-->Router---
>leased-line/vsat<---
Router<--LAN di Surabaya

Dengan cara di atas, dibutuh-
kan biaya besar untuk konek-
si leased-line antar kota.

Private Network (Contoh B)

PC di rumah-->Modem---
>Telkom<---Modem Server
<--HUB<--LAN di kantor

Dengan cara diatas, proses
dial dari rumah ke kantor,
harus dilakukan secara lang-
sung, baik menggunakan pul-
sa lokal, SLJJ, bahkah SLI,
tergantung lokasi.

Virtual Private Network
(Contoh A)

LAN di Jakarta-->Sesi VPN-
->Router--->Internet<---
Router<--Sesi VPN<--LAN
di Surabaya

Virtual Private Network
(Contoh B)

PC di rumah-->sesi VPN--
>Modem--->Internet<---
Router<--sesi VPN<--
HUB<--LAN di kantor

Dengan menggunakan VPN,
maka masing-masing pihak
cukup konek ke ISP dengan
biaya lokal, dan tetap bisa
bertukar informasi dengan
aman.

Sesi VPN (VPN Session) ini
adalah gabungan dari oten-
tikasi dan encrypt/decrypt
atau "tunnel/terowongan"
Internet dengan mengguna-
kan protokol network (mi-
salnya TCP/IP).

Implementasi VPN bisa di-
mulai dari yang sederhana,
misalnya di Windows sudah
ada fasilitas VPN. Untuk
perusahaan besar, proses VPN
bisa dilakukan oleh firewall
atau box khusus untuk VPN.
Semua tergantung berapa
tinggi tingkat keamanan
yang ingin dicapai.

Albert Siagian
asiagian@gmx.net

VOIP
T: Posted July 23
Jaringan Cabang dan pusat
seperti ini, terhubung ke
internet 

[ komputer ---- LAN -----
Server ] ----- [ LAN ----
komputer ] cabang | pusat | 
Server ---- Internet
Saya ingin menambah VOIP
di jaringan cabang dan pusat,
bisakah VOIP ikut
jaringan tsb ataukah mema-
kai jaringan tersendiri.

Wahyu Budi
wbudi@satelindo.co.id

J: Posted July 23
VOIP bisa ikut jaringan terse-
but, dengan catatan band-
widthnya berbagi pakai. Se-
ingat saya 1 line sekitar 8Kbps.
Misalnya anda pakai leased-
line 64Kbps, dan dipakai oleh
1 line, maka untuk data akan
turun jadi 56Kbps (+ VOIP
8Kbps). Dengan catatan
router anda support VOIP.

Albert Siagian
asiagian@gmx.net

DLL Ditaruh di Mana?
T: Posted July 22
Sorry berhubung engga per-
nah ngutak-ngatik windows
file DLL di taro dimana ya?
Lagi mau mainan openh323
di windows bentuknya DLL
engga tahu di taro dimana ..

Onno W. Purbo
onno@indo.net.id

J: Posted July 22
Terserah pak Onno saja deh
:) karena pada OS Windows
file DLL itu tidak tergantung
dimana dia diletakan jadi
cukup taruh di sembarang
tempat yang diinginkan.
Lalu register file DLL terse-
but dengan menggunakan
RegSvr32 <nama_file_ dll>
tujuannya agar properties
file DLL terdaftar di registry,
Termasuk no IDL dan juga
method2x yang dalamnya
shg aplikasi dapat mema-
kainya cuman ada beberapa
org mengumpulkan dalam
satu direktori tertentu mi-
sal file DLL untuk system
OS Windows, akan disim-
pan di folder windows da-
lam bagian folder system32
atau system, tujuannya
supaya rapi saja :)

Agus Kurniawan
akurniawan@balicamp.com
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ENGAN HANYA MENEBAK PASSWORD YANG LEMAH,
penyerang dapat dengan mudah mendapatkan
akses ke dalam sistem, mendapatkan informasi

penting, atau menghentikan suatu sistem.

Banyak yang mengelola password dengan tidak hati-hati,
seperti misalnya menggunakan kata 'password' untuk pass-
word-nya atau password yang sama dengan user name-
nya. Sekali penyerang masuk dengan menggunakan user
name yang password-nya lemah, maka tahap berikutnya
adalah mencari password administrator network untuk
meningkatkan privilege-nya dalam network itu.

Mem-bypass Password
Windows 9x/ME tidak mempunyai konsep logon multi-
user, sehingga setiap orang dapat dengan mudah meng-
akses komputer yang menggunakan Windows 9x dengan
cara mematikan dan menghidupkan kembali komputer itu
atau dengan Ctrl-Alt-Del. Permintaan memasukkan pass-
word pada saat logon ke Windows 9x semata-mata hanya
kosmetik saja. Pada Windows 95 versi awal, Ctrl-Alt-Del
bahkan dapat mengatasi screen-saver password! Teknik
ini dikenal sebagai console hacking.

BIOS Password
Cara tradisional untuk mengatasi console hacking adalah
dengan menerapkan BIOS password. BIOS (Basic Input

Output System) terpasang secara hardware pada mother-
board dan menjalankan fungsi boot pada komputer PC.
BIOS dengan demikian merupakan komponen pertama
yang harus dilewati untuk masuk ke dalam sistem.

Hampir semua pembuat motherboard menyediakan fasi-
litas BIOS password untuk mencegah masuknya penyusup
amatiran ke dalam sistem komputer. Penyusup yang lebih
canggih tetunya dapat saja mematikan BIOS password de-
ngan mengangkat baterai yang terpasang pada mother-
board atau bahkan 'meminjam' hard disk anda dan mema-
sangnya pada komputer lain. Selain itu terdapat pula ber-
bagai jenis BIOS password cracking, sehingga BIOS pass-
word tetap saja tidak aman. Namun BIOS password sudah
memadai untuk mencegah masuknya penyusup amatiran.

Screen Saver Password
Selain BIOS password, pertahanan lapis kedua adalah screen
saver password. Screen saver password dipasang lewat
Display Properties pada Control Panel. Screen Saver tidak
bisa diaktifkan secara manual, melainkan hanya akan di-
aktifkan setelah beberapa waktu komputer tidak aktif (da-
pat ditetapkan mulai dengan satu menit).
Apabila pada sistem anda terpasang juga Microsoft Office,
maka screen saver dapat diaktifkan dengan jalan memodi-
fikasi Office Startup Application (OSA) dengan meng-
ganti switch -b menjadi -s pada menu Startup.

D

Seni dan TSeni dan Tekniknyaekniknya
PPasswassworord Crd Crackingacking

Password adalah alat pengamanan komputer yang paling lazim digunakan.
Password yang mudah ditebak merupakan mata rantai yang paling lemah dalam
sistem keamanan suatu sistem. NeoTek membawakan serangkaian tulisan untuk mengenal

password dan betapa password yang lemah  mudah ditembus oleh penyusup. 

3 UBAH PARAMETER
Akan tampak pada target bahwa
untuk menjalankan MS Office pada
waktu Startup, yang dijalankan ada-
lah file OSA.EXE (atau OSA9.EXE
pada MS Office 2000). Ubah para-
meter -b menjadi -s. Kini setiap kali
Start, screen saver akan dijalankan.

START UP MICROSOFT OFFICE
Melalui Start → Programs →
Startup, cari entri Office Startup
(pada MS Office 97) atau Microsoft
Office (pada Office 2000) yang
mengaktifkan Microsoft Office
setiap kali komputer dijalankan.

PROPERTY
Klik kanan pada ikon Office Startup
(atau Microsoft Office) untuk me-
nampilkan pilihan menu selanjut-
nya. Pilih Properties untuk menam-
pilkan jendela dialog Microsoft
Office Properties.

1 2

Mengaktifkan Screen Saver pada Saat Startup

September 2002 NeoTek
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Password Cracking
Apa yang dimaksud dengan password cracking? Password
cracking adalah kegiatan menebak suatu password dengan
menggunakan encrypted password-nya. Ada banyak cara
untuk melaksanakannya. Cara yang paling sederhana adalah
menebak password dan meng-input-kannya sampai didapat
password yang diterima. Untuk itu yang perlu diketahui
adalah user ID dan akses ke prompt logon pada network.

Password cracking secara manual mengikuti langkah-lang-
kah sebagai berikut:

a. Dapatkan user ID yang absah

b. Ciptakan daftar password yang mungkin

c. Susun password-password ini mulai dari yang paling
besar peluangnya

d. Ketikkan setiap password

e. Bila sistem mengizinkan anda masuk, maka sukses!

f. Bila tidak, coba lagi dengan memperhatikan password
lockout (berapa kali boleh memasukkan password yang
keliru sampai sistem menutup dan tidak mengizinkan
anda mencoba lagi).

Pada prinsipnya caranya sangat mudah, hanya saja me-
makan waktu. Maka lebih banyak digunakan cara untuk
mengotomatisasi kegiatan password cracking. Untuk cara
otomatis ini, diperlukan satu hal lagi, yaitu file password
yang terenkripsi.

Langkah-langkah yang digunakan untuk otomatisasi
password cracking adalah sebagai berikut:

a. Dapatkan user ID yang absah

b. Dapatkan algoritma enkripsi yang digunakan

c. Dapatkan password yang terenkripsi

d. Ciptakan daftar password yang mungkin

e. Enkrip setiap kata yang akan dicobakan

f. Periksa apakah cocok untuk setiap user ID

g. Ulangi langkah a sampai f

Langkah b (mendapatkan algoritma enkripsi) sudah dike-
tahui untuk berbagai macam sistem. Windows 9x./ME
menggunakan enkripsi sederhana untuk screen saver pass-
word, sehingga screen saver password dapat dengan mudah
di-crack. Windows NT/2000 dan Unix menggunakan algo-
ritma yang lebih sulit ditembus, namun tetap saja ter-
dapat tool untuk meng-crack password baik pada NT/2000
maupun Unix.

Telah tersedia perbagai macam tool untuk meng-crack
password mengikuti cara otomatisasi di atas. Apabila
untuk meng-crack password yang terdapat dalam bentuk
file terenkripsi masih diperlukan password attack, maka
untuk password yang tersimpan dalam cache memory
akan dengan mudah diungkapkan oleh password revealer.

Dengan demikian, apabila anda meminta Windows me-
nyimpankan password anda, maka password itu dengan
sangat mudah dapat terungkap.

Mengungkap Cached Password
Bila penyusup sudah dapat mematahkan pertahanan BIOS
password dan screen saver password, maka tahap berikut-
nya adalah mengungkap password yang tersimpan dalam
memori sistem yang 'terlindung' dengan tanda asterisk
sebagai ********. Tanda asterisk ini menandakan bahwa
password tersimpan dalam sistem, hanya ditutup dengan
tanda asterisk tadi. Fasilitas yang ditawarkan Windows
untuk mengingat password kita memang nyaman, namun
masalah dapat timbul apabila kita lupa akan password kita
sendiri. Untuk itulah fungsi dari software pengungkap
password, yang mengungkap password dari password
yang tersimpan dalam sistem (cached).

Salah satu pengungkap password yang terkenal adalah
Snadboy's Revelation (www.snadboy.com) yang cara
kerjanya begitu mudah dalam mengungkap password
yang disembunyikan di bawah tanda asterisk. Software
lain yang serupa di antaranya 007 Password Recovery,
ShoWin, Unhide, Pwltool, Pwlview, dan Dial-up Ripper
(dripper). Semua software ini pada dasarnya digunakan
untuk mengungkapkan password kita sendiri apabila kita
lupa akan password itu, sebab semuanya hanya dapat
digunakan setelah melewati sessi logon.

3 SHOWIN 2.O DAN DRIPPER
ShoWin 2.0 mengungkapkan
boxed password sepeti Snadboy’s
Revelation. Dial Up Ripper
(dripper) mengungkapkan cached
password khusus untuk dial up
networking.

SNADBOY’S REVELATION
Cache password dengan mudah
diungkapkan oleh Snadboy’s Reve-
lation dengan membuka tirai
asterisk ****** yang menyembunyi-
kan password sebenarnya yang
tersimpan dalam sistem atas
permintaan anda sendiri.

007 PASSWORD RECOVERY
007 Password Recovery dijalankan
dengan menggeret ikon anak kunci
ke tempat boxed password yang
akan menampilkan password dari
yang sebelumnya tanda asterisk
******** Unhide dijalankan dengan
mengklik Refresh List.

1 2

Berbagai Macam Password Revealer

Screen saver password juga dapat di-bypass. Hal ini di-
mungkinkan karena kelemahan yang ada pada sistem
Windows 9x/ME.

Kelemahan pertama adalah bahwa sistem Windows 9x/ME
yang menggunakan CD ROM akan menjalankan file
Autorun.inf walaupun screen saver sedang dijalankan.
Jadi sementara anda diminta memasukkan password
screen saver untuk dapat mengakses sistem, sebenarnya
sistem sudah diakses apabila anda memasukkan CD yang
mempunyai autorun ke CD ROM drive. Hal ini dapat
dimanfaatkan untuk menjalankan program apa saja,
terutama trojan seperti NetBus atau Back Orifice.

Kelemahan kedua adalah bahwa data mengenai screen
saver password disimpan dalam registry, tepatnya di ba-
wah segmen HKEY_USERS\.DEFAULT\Control Panel\
Desktop serta dalam file USER.DAT pada direktori Win-
dows. Screen saver password dengan demikian dapat di-
bypass ataupun di-crack.

Untuk mem-bypass screen saver password dapat diguna-
kan SSBypass, yang CD-nya dapat dibeli seharga US$39.95
lewat http://www.amecisco.com/ssbypass.htm. Anda akan
mendapatkan CD yang bila dipasang pada CD ROM drive

akan segera mengakses sistem dengan mem-bypass layar
yang meminta anda memasukkan password screen saver.
Software ini pada dasarnya menarik data dari registry
dan/atau USER.DAT, men-dekripsi file ini untuk men-
dapatkan password-nya, dan memasukkan password ini ke
sistem Windows 9x/ME.

Untuk mengatasi screen saver bypass pada Windows 9x
/ME (pada NT/2000 kelemahan ini telah diatasi oleh
Microsoft) non-aktifkan fitur CD ROM Autorun dengan:

a. Pada Control Panel, double click System

b. Klik tab Device Manager

c. Double click CD ROM lalu double click entri CD ROM
driver

d. Pada tab Setting, pastikan check box Auto Insert
Notification kosong.

e. Klik OK lalu Close untuk kembali ke Control Panel.
Bila diminta untuk me-restart komputer, klik Yes.

Ada juga freeware untuk men-dekripsi screen saver pass-
word ini, yaitu 95sscrk.exe yang dapat men-dekripsi screen
saver password baik lewat USER.DAT maupun lewat seg-
men registri yang diekspor menjadi namafile.reg.

3 CRACK PASSWORD-NYA
Crack screen saver password yang
ada pada USER.REG ini dengan
mengaktifkan DOS prompt, masuk
ke folder C:\95sscrk dan ketikkan:
C:\>95sscrk user.reg
dan screen saver password pun
ditampilkan!

EKSPOR SEGMEN REGISTRY
Setelah menjalankan regedit (Start
→ Run lalu ketikkan regedit), pada
segmen yang terdapat screen saver
password pilih menu Registry lalu
pilih Export Registry File...

SAVE REGISTRY SEGMENT
Akan tampil jendela dialog Export
Registry File yang akan men-save
segmen registry yang anda buka ke
file dengan ekstensi .REG. Dalam
contoh kita namakan file ini
USER.REG disimpan pada folder
yang sama dengan 95sscrk.exe

1 2

Mengekspor Segmen Registry yang Berisi Screen Saver Password

• Informasi screen saver password
terdapat pada registry, di bawah segmen

HKEY_USERS\.DEFAULT\Control Panel\Desktop
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File Password pada Windows NT
Pada Windows NT, password untuk setiap account (disebut
password hash) pada security database yang seringkali di-
sebut sebagai SAM atau security account manager. Loka-
si file di \Windows\system32\config\SAM. File ini dapat
dibaca namun tidak dapat diakses sebab dikunci oleh ker-
nel siytem.

Sewaktu instalasi NT, password database disalin ke direk-
tori Windows/repair. File ini belum berisi account apa-apa
selain default account. Tetapi jangan lupa, biasanya default
account adalah account tingkat administrator.

User NT memasukkan password sebagai teks biasa, lalu NT
menjalankan dua algoritma. Yang petama untuk NT hash
biasa dan satunya lagi untuk LANMAN hash. Untuk meng-
hitung NT hash biasa, Microsoft mengubah password itu
ke Unicode dan kemudian menjalankannya pada algoritma
hash MD4 untuk mendapatkan nilai 16-byte.

Untuk menghitung LAN Manager hash, Microsoft meng-
isi password yang bersangkutan dengan angka-angka 0
sampai 14 karakter panjangnya. Lalu diubah ke huruf
kapital dan memecahnya menjadi dua potong yang masing-
masing panjangnya 7 karakter. Untuk setiap potongan itu
dihitung kunci-kunci untuk 8-byte odd parity DES-nya
(data encryption standard), lalu kunci-kunci ini dienkripsi
dan dikombinasikan menjadi suatu nilai hash 16-byte.

Pada dasarnya semua password dapat di-crack. Hanya per-
tanyaannya adalah dalam waktu berapa lama? Fungsi en-
kripsi adalah membuat proses password cracking menjadi
begitu lama sehingga tidak layak untuk dilakukan. Namun
demikian, dibandingkan Unix, password pada Windows
NT dapat lebih cepat di-crack karena adanya kelemahan
desain dalam enkripsinya yang tidak membedakan huruf
kapital dari huruf kecil. Kemudian memecah password
menjadi dua bagian juga menyebabkannya lebih mudah
di-crack.

Program untuk meng-crack password pada Windows NT
di antaranya L0phtcrack, NTSweep, NTCrack, dan
PWDump2. L0phtcrack adalah NT password cracking
yang paling baik sekarang ini, sedangkan PWDump2

sebenarnya bukanlah password cracker, melainkan hanya
mengekstrak password hashes. PWDump2 masih diperlu-
kan karena ukurannya yang kecil dan ada beberapa pass-
word hashes pada NT yang tidak dapat diekstrak sendiri
oleh L0phtcrack.

Mengenal L0phtcrack
Mengapa L0phtcrack begitu terkenal dan berharga? Keba-
nyakan program password cracking mengandalkan kamus
dan berasumsi bahwa administrator jaringan mempunyai
password yang sudah dienkripsi yang bisa dicuri untuk
kemudian di-crack. L0phtcrack tidak mengandalkan ker-
janya pada asumsi-asumsi di atas dan menyertakan be-
berapa feature sebagai berikut:

a. Password cracking

b. Ekstrak hashes dari password registry

c. Loading password dari suatu file

d. Sniffing password pada network

e. Menjalankan dictionary, hybrid, brute force atack atau
kombinasinya.

L0phtcrack hanya berjalan pada lingkungan Windows
NT/2000.

NTCrack dan NTSweep
NTCrack serupa dengan UNIX password cracking program
dan berjalan di lingkungan DOS pada semua sistem Windows.
Baik NTCrack maupun NTSweep memerlukan user ID yang
absah dan kombinasi-kombinasi password untuk dicoba.

What Do You Want to Crack Today?
Selain file .PWL kini segala macam password dapat diung-
kap (di-crack), mulai dari file .PST pada Microsoft Outlook
sampai password pada Microsoft Word, Excel, dan Power-
point. Bahkan terdapat juga password cracker untuk file
.ZIP seperti misalnya Advanced Zip Password Recovery
(AZPR) dari Elcomsoft, Russia. Pelbagai password cracker
dari Elcomsoft menggunakan teknik dictonary, plain text,
maupun brute-force attack dan berlangsung amat cepat
dengan lebih dari 500.000 tebakan password tiap detiknya.

3 NTPASSWORD
NT password cracker yang juga mu-
dah digunakan adalah ntpassword.
Menu Audit-nya terdiri dari impor
hashes serta Option untuk melaku-
kan crack berdasarkan brute force
(karakter yang disertakan dapat di-
tentukan) serta dictionary attack.

L0PHTCRACK
L0phtcrack merupakan NT pass-
word cracker yang sangat tangguh.
Mempunyai kemampuan meng-
impor file password baik dari local
machine, remote registry, SAM file,
sniffer, LC file, maupun PWL file.

IMPORT REMOTE REGISTRY
Salah satu kehebatan L0phtcrack
adalah kemampuannya mengimpor
remote registry. Cukup masukkan IP
address dari suatu mesin NT dan
dengan mudah passwod terenkripsi
dari mesin NT itu akan diperoleh
untuk kemudian di-crack.

1 2

Berbagai Macam NT Password Cracker

File Password pada Windows 9x/ME
Password pada sistem Windows tersimpan dan terenkripsi
dalam file .PWL di direktori C:\WINDOWS. File-file ini
diberi nama berdasarkan setiap user profile. File-file .PWL
dapat di-copy ke disket dengan perintah sederhana:

C:\>copy C:\Windows\*.pwl a:

Sekali seseorang telah mendapatkan file-file .PWL maka
kini dengan sabar dia dapat mencoba meng-crack-nya.
Windows 95 edisi awal menggunakan algoritma enkripsi
sederhana sehingga file-file .PWL dapat dengan mudah di-
crack. Algoritma yang digunakan pada file .PWL yang
sekarang lebih kuat, namun tetap berdasarkan nama yang
digunakan sewaktu user logon.

File .PWL pada dasarnya adalah daftar password yang di-
cached untuk mengakses network resource sebagai
berikut:

a. Resource yang dilindungi oleh share-level security

b. Aplikasi yang menggunakan password caching seperti
Dial-Up Networking

c. Komputer-komputer Windows yang berada di luar
domain

d. Password logon ke Windows yang bukan merupakan
logon primer pada network.

e. Server NetWare.

PWL cracking pada dasarnya dilakukan dengan cara me-
lakukan dictionary attack atau brute-force attack terhadap
file .PWL bersangkutan.

Pwltool melakukan dictionary attack terhadap file .PWL
yang kehebatannya tergantung pada besarnya ukuran
kamus yang digunakan. Agar suatu kamus dapat diguna-
kan oleh Pwltool, kata-kata pada kamus tersebut harus
diubah menjadi huruf kapital semua.

Tool lain yang juga bagus untuk meng-crack file .PWL
adalah Cain (versi 2.0 untuk Windows 9x/ME dan versi
2.5 untuk Windows NT/2000). Cain menggunakan dict-
ionary attack maupun brute-force attack untuk meng-
crack password yang terdapat pada file .PWL. Cain akan
dikenali sebagai virus oleh antivirus.

3 BRUTE FORCE
Bila anda meng-klik .PWL files
attack, maka tampil file-file .PWL
yang ada. Dengan mengkliknya,
serangan brute force langsung
dilaksanakan.

CACHED PASSWORD
Begitu Cain 2.0 dijalankan langsung
semua cached password yang ada
ditampilkan, baik itu cached pass-
word dial up networking, local
resource, maupun remote resource
yang pernah diakses.

PASSWORD ATTACK APA SAJA?
Membuka cached password hanya
salah satu dari banyak kemampuan
Cain 2.0: user .DAT files, local shares,
cached password, .PWL files, remote
share, Access database, sampai
SMB Password. Juga terdapat Abel
client yang memonitor Abel server.

1 2

Cain Password Stealer

• PWLTool dan Pwlview
mengungkapkan berbagai
macam pasword yang ada

pada file .PWL
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6 DARI USER.DAT FILE
Klik ikon ke-3 (Attack > User.dat
files); klik tanda + (kiri atas, atau
File > Add to List); cari file user.dat
yang terdapat di bawah direktori
Windows. Screen saver password
yang pernah dipakai akan tampil.
Terlihat ada dua screen saver pass-
word, yang sekarang dan sebe-
lumnya.

arena sangat lengkap dan mudah
digunakan, Cain 2.0 sangat baik
untuk memahami konsep password

cracking, baik untuk komputer lokal milik
sendiri maupun komputer lain.

Cain dapat mengakses komputer lain yang
ada pada LAN maupun Internet, terutama
apabila komputer tersebut mempunyai share
yang dapat diakses. Apabila terdapat cached
password, maka share segera dapat diak-
ses, bila tidak, gunakan fasilitas dictionary
atau brute force attack.

Abel server akan terinstalasi bersama Cain.
Server ini harus anda nonaktifkan, sebab
bila tidak anda sendiri akan menjadi target
komputer lain yang menjalankan Cain
yang juga merupakan Abel client.

CCAIAIN & ABN & ABEEL 2.0L 2.0
PPAASSANANGGANAN
PPEENNCCUURRI PI PAASSSWSWOORRDD
Untuk lebih memahami aspek-aspek password cracking,
akan kita bahas ‘software terbaik’ untuk keperluan ini Cain
(lengkapnya adalah Cain & Abel), yang terdapat dalam dua
versi. Versi 2.0 yang berjalan pada Windows 9x/ME dan
versi 2.5 yang berjalan pada Windows NT/2000.

K

INSERT REMOTE SHARE
Ini yang paling seru, mencari pass-
word di komputer orang! Dapatkan
IP dari komputer yang dapat diakses
(dapat menggunakan Legion 2.1)
atau dalam contoh ini dalam LAN
yang sama. Klik icon ke-7 lalu klik
tanda + untuk menampilkan menu
dialog ‘Insert a remote share.’

REMOTE SHARES PASSWORD
Pada LAN contoh ini terdapat tiga re-
mote share pada dua komputer. Untuk
meng-crack password di masing-masing
share cukup double click pada masing-
masing share dan apabila terdapat
cached password (baru diketik atau
tidak ada) maka anda langsung ter-
hubung ke share tersebut.

SCREEN SAVER PASSWORD
Klik ikon yang terletak paling kiri ba-
wah (atau menu Attack > Screen
Saver) maka akan tampil informasi
mengenai screen saver password
pada komputer lokal anda. Ini mudah
dilakukan mengingat screen saver
password terdapat di registry de-
ngan enkripsi sederhana saja.

BOXED PASSWORD
Boxed password (yang tampak se-
bagai *******) dapat diungkap de-
ngan mengklik ikon kedua dari
ujung kiri bawah (Attack → Boxed
Passwords) setelah terlebih dahulu
boxed password itu ditampilkan.
Pada contoh ini adalah password
dial up networking.

4
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SMB PASSWORD RECOVER
Cain memungkinkan anda men-
dapatkan Windows 9x/ME/NT dan
Samba password dengan jalan
mendekrispsi MD4 hash-nya.
MD4 hash dapat diperoleh dari
file SAM pada NT serta melalui
tool seperti Pwdump, Pwdump2,
L0phtcrack, serta melalui sniffing.

ABEL CLIENT
Cain juga merupakan client dari
Abel. Klik icon paling kanan bawah
dan klik + serta masukkan IP ad-
dress dari komputer yang diketa-
hui dapat diakses (pada LAN atau
di luar dengan Legion). Klik kanan
dan pilih Refresh. Tampak bahwa
Abel server belum terpasang.

LOCAL SHARE
Untuk menunjukkan share yang
terdapat paka komputer anda, klik
ikon keempat (Attack > Local Shares)
dan akan tampil tiga shares yaitu
printer dan dua hard disk. Hard
disk D hanya read-only sedangkan
hard disk C bisa full atau read-
only, tergantung password-nya

PWL FILE
Untuk mendapatkan password
yang tersimpan pada PWL file klik
ikon kelima. Terlihat bahwa PWL
tersebut dibentuk oleh Windows
98 release 2 (OSR2/98) yang lebih
sulit di-crack. Untuk meng-crack-
nya dengan dictionary attack dan
brute force, double click padanya.

7
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Fasilitas password cracking lengkap dengan fasilitas remote control terhadap komputer lain.

ACCESS PASSWORD MANAGER
Microsoft Access menggunakan sis-
tem password yang amat lemah
dan dengan Cain anda dapat lang-
sung mendapatkan password dari
suatu file .MDB serta dapat pula
mengubahnya melalui Cain. Telah
teruji pada Microsoft Access 97.

12

CAIN CONFIGURATION
Dictionary dan brute force attack di
Langkah 8 dapat dikonfigurasi dengan
klik menu Configure yang akan me-
nampilkan Cain Configuration Dialog.
Anda dapat men-set apakah karakter-
karakter di luar abjad dan angka
akan dipakai dalam brute force dan
kamus apa yang akan dipakai.

9

KILL ABEL DI KOMPUTER LOKAL
Pada komputer anda sendiri ter-
dapat Abel server (artinya anda da-
pat diserang dari luar). Matikan Abel
dengan menjalankan killabel.exe
yang terdapat pada direktori
\Program Files\Cain (diakses mela-
lui Windows Explorer dan double
click pada killabel.exe).

15

INSTAL CAIN 2.0
Instal Cain 2.0 dari CD NeoTek
atau dapat juga di-download dari
http://www.oxid.it. Akan tampil
layar awal instalasi Cain 2.0, klik
Next dan ikuti langkah-langkah-
nya sampai selesai.

ICON CAIN PADA DESKTOP
Akan tampak ikon Cain v2.0
pada desktop komputer anda.
Double click ikon ini untuk
menjalankan Cain. Langsung
Cain akan menunjukkan semua
cache password yang terdapat
pada komputer anda.

1 2 FITUR-FITUR CAIN 2.0
Dari menu Attack atau ikon di bagian
bawah terlihat secara berurutan fitur-
fitur: screen saver, edit box password,
user .dat files, local shares, cache
passwords, PWL files, remote shares,
SMB passwords, dan Abel client.

3
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6 SMB SNIFFER
Cain dapat meng-crack password yang
diperoleh dengan melakukan sniffing
melalui network card yang tersedia.
Klik SMB Sniffer dan jendela dialog
SMB Sniffer @192.168.123.106 klik
tombol Configure dan tetapkan (Set)
adapter LAN pada remote computer
sebagai sniffer. Tick autostart sniffer.

ewaktu instalaasi Cain, akan terben-
tuk pula abel.exe yang apabila kom-
puter di-boot akan mengaktifkan

Abel server dengan menjalankan Abel.exe
tadi. Abel server hanya dapat di-nonaktifkan
lewat Cain.

Walaupun abel server sudah dinonaktifkan
dan abel.exe sudah dihapus, namun sewak-
tu boot tetap saja abel server dijalankan
(tanpa sepengeahuan kita) sebab dengan
menjalankan abel.exe akan terbentuk
msabel32.exe pada direktori Windows\system
serta registri khusus yang akan menjalan-
kan Abel server setiap kali boot.

Karena berbahaya, abel.exe dan msabel32.exe
akan dikenali sebagai virus PWL.Cain Pass-
word Stealer oleh kebanyakan antivirus.

CCAIAIN & ABN & ABEEL 2.0L 2.0
MMEENNGGEENNDDALIALIKKANAN
RREEMMOOTTE COE COMMPPUUTTEERR
Selain password cracking terhadap local computer, kelebihan
Cain adalah fungsinya sebagai Abel client, yang memonitor
dan mengendalikan remote computer yang telah terpasang
Abel server. Abel server akan secara terotomatis terpasang juga
sewaktu anda menginstal Cain. Jadi hati-hati!

S

GENERAL INFORMATION
Pilihan General Information sebenar-
nya lebih dari sekedar informasi. Me-
mang terdapat informasi tentang re-
mote host di window pane kanan,
namun di window pane kiri terdapat
command untuk remote host. Salah
satunya adalah Toggle Password Ca-
ching. Pilih lalu klik Send Command.

SEND COMMAND YANG LAIN
Masih banyak perintah lain yang dapat
dikirim ke remote host. Di antaranya
mematikan Abel (Abel server tidak
dapat dimatikan dari host itu sendiri)
atau dapat juga kita meminta pemakai
komputer host mengganti password
windows, network, atau screen saver.
Semuanya akan di-sniffing tentu.

ABEL.EXE AKTIF
Kini, pada remote computer, abel.exe
sudah aktif, terlihat dari tanda A pada
toolbar. Pada komputer remote yang
lain sebenarnya Cain sudah diha-
pus, tetapi tunggu... abel server tetap
aktif tanpa disadari. Jadi di kom-
puter anda sekarang pun ada abel
server yang berjalan.

BISA APA SAJA?
Apa saja yang bisa dilakukan
terhadap remote computer yang
sudah terpasang abel server? Klik
kanan pada Host name dan di
bawah Refresh terdapat: General
Information, Shares, Cached
Resources, PWL files, dan SMB
Sniffer.

4
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DIREKTORI UNTUK TIAP HOST
Tampak pada direktori itu terben-
tuk dua subdirektori yang masing-
masing untuk host yang diakses
oleh Cain. Di dalam setiap sub-
direktori terdapat file-file PWL dan
system.ini yang diperoleh dari
masing-masing host. Waktu untuk
meng-crack kini di pihak anda.

MAU ISENG JUGA?
Perintah lain yang dapat menge-
jutkan pemakai di komputer host
adalah Windows Logoff, Windows
restart, dan Windows shutdown.
Tapi ini juga ada fungsinya sebab
dengan cara ini pemakai yang tidak
sadar dirinya dikendalkan akan
mengetikkan password kembali.

UPLOAD DRIVER & AKTIFKAN
Selanjutnya klik tombol Upload dri-
ver untuk meng-upload sniffer driver
(Klik OK), lalu klik tombol Start/Stop
untuk mengaktifkan atau menon-
aktifkan kegiatan sniffing pada remote
computer tadi. Terakhir klik tombol
Refresh untuk melihat status ter-
akhir, yaitu Sniffer diaktifkan.

REFRESH STATUS REMOTE
Pada Host Name/IP Address klik
kanan dan pilih Refresh dan status
kedua remote host di-update. Tam-
pak pada kedua host abel server
telah terinstal, tetapi hanya pada
yang pertama sniffer telah
terpasang dan diaktifkan.
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Abel server yang terpasang pada suatu komputer membuatnya dapat diakses lewat Internet.

CAIN CONFIGURATION
Klik menu Configure pada Cain
dan pilih tab Grab Option. Tampak
apa saja yang dipilih untuk diam-
bil: cache password, PWL files,
atau registry file serta system.ini.
Semuanya disimpan secara
default di C:\Program Files\Cain 

12

FASILITAS REMOTE LAIN
Selain mengaktifkan SMB Sniffer,
terdapat fasilitas-fasilitas lain terha-
dap remote host, yaitu: menampil-
kan Shares, Cache Resources, dan
PWL files. Semua ini adalah infor-
masi yang ada pada remote host,
bukan yang ada pada local compu-
ter anda.

9

DISCONNECT NETWORK DRIVE
Bila kegiatan sudah selesai, anda
dapat memilih opsi Disconnect Net-
work Drive. Ini bukan berarti akses
terhadap host terhenti. Abel server
akan terus bekerja apabila host
berjalan dan bila terhubung ke In-
ternet (atau LAN) akan mengirim-
kan hasil sniffing ke Abel client.

15

MAP NETWORK DRIVE
Terhadap remote resource yang
sudah connected, kita bisa
lakukan mapping sebagai local
resource. Klik icon Map Network
Drive dan tetapkan suatu share
(di sini \\COMPAQ_HEDHI\C) ke
G: di komputer lokal anda.

DRIVE G; PADA MY COMPUTER
Klik icon My Computer pada
desktop dan di dalamnya akan
tampak drive G: yang merupakan
network drive yang di-mapping
menjadi drive G: di komputer
anda. Anda bisa perlakukan drive
ini sebagai drive anda sendiri.

1 2 COPY-KAN ABEL.EXE
Copy-kan abel.exe dari C:\Program
Files\Cain ke drive G: ini. Pada con-
toh dibuatkan direktori Abel pada
network drive tersebut. Misalkan
pemilik drive itu terjebak menjalan-
kan abel.exe.

3
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0pthcrack dibuat oleh suatu ke-
lompok administrator ahli yang
menamakan diri mereka dengan

sebutan “L0pth.” Program ini banyak di-
gunakan oleh para administrator NT/2000
untuk menguji password komputer mau-
pun password user mereka.

L0pthCrack mengaudit dan memulihkan
password dengan berbagai cara. Pada
dasarnya menggunakan kamus untuk
menemukan password. Jika kata dalam
kamus tersebut sesuai dengan password,
maka akan ditampilkan pada layar.

Karena itu janganlah bosan mengkoleksi
kamus kata-kata, yang bisa anda dapat-
kan di situs internet.
david_sugianto2002@yahoo.com

L

TAMPILAN LAPORAN
Bentuk laporan pun dapat
dipilih: menampilkan password
sewaktu audit, menampilkan
password hashed terenkripsi,
menampilkan lamanya audit,
dan menampilkan proses audit.

4
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Konfirmasi
Sebelum proses audit dilakukan,
anda diberi kesempatan untuk
memeriksa kembali pengaturan
yang anda buat sebelumnya,
jika sudah sesuai, klik Finish.

TAMPILAN PASSWORD
Aha... ternyata password admin-
istrator pada komputer yang
sedang digunakan adalah
123456 dan password untuk
Guest kosong (* empty *).

TAMPILAN PASSWORD
Lakukan seperti langkah 1–6,
kemudian hasilnya pun akan
segera keluar. Password user
yang baru anda buat juga da-
pat di-crack dan ditampilkan.
Buatlah user baru lagi dengan
username Anton dan pass-
word hantu_tampan.

BUKA CONTROL PANEL
Buka Control Panel dan klik
dua kali pada ikon Users and
Password untuk menampilkan
kotak dialog User and Pass-
word.

MEMBUAT USER BARU
Klik tombol Add untuk mem-
buat user baru dan kotak dialog
Add New User akan muncul.
Isikan Username dengan
im_david lalu klik Next dan isi
password dengan davidian. Lalu
daftarkan sebagai group Guest.

MEMBUKA LAYAR WIZARD
Klik ikon bergambar tongkat
sulap pada toolbar atau pilih
menu File > LC3Wizard untuk
menampilkan layar wizard

TAMPILAN PASSWORD
Berhasil… password pada
user Anton kini dapat di-
crack serta ditampilkan. Hal
ini menunjukkan bahwa
L0pthcrack bekerja berdasar-
kan file kamus yang tersedia.

BUAT KAMUS
Buatlah kamus kata anda sendiri
yang terdiri atas kata-kata yang
umum untuk dijadikan password.
Atau anda dapat juga menda-
patkannya dari internet melalui
situs yang menyediakan. Sim-
panlah pada folder tempat
program L0pthCrack disimpan.

MENGGANTI KAMUS
Kembali ke layar wizard dan ke-
tika tiba pada layar seperti diatas,
silahkan pilih Costum kemudian
klik Costum Option... Ubah kamus
yang akan digunakan untuk me-
lakukan audit password dengan
mengisikan nama file kamus
anda pada kotak teks.

1 2 3
METODE AUDIT
L0pthCrack juga dapat mela-
kukan empat macam cara
dalam meng-crack password.
Pilihlah pilihan pertama yaitu
Quick Password Audit dan klik
Next

BUKA KAMUS
Dengan Windows Explorer ma-
suk ke folder tempat program
L0pthCrack disimpan dan klik
dua kali pada file word-english.
Pada waktu kotak dialog
Open With... tampil, pilih
Notepad untuk membukanya.

MENAMBAH KATA
Tambahkan hantu_tampan
pada daftar kata yang ada di
dalam file word-english dan
kemudian simpan dengan
nama yang sama.

L0phtctack yang menggunakan kamus dalam proses cracking, dilengkapi juga dengan sniffer.

L0PL0PHHTTCCRRAACCK 3K 3
NNT PT PAASSSWSWOORRDD
CCRRAACCKKEERR
Pada dasarnya semua password dapat di-crack, yang membedakan
suatu password cracker dari lainnya adalah kecepatan dalam
melakukan dictionary attack atau brute force attack. Salah satu
password cracker yang tangguh adalah L0phtcrack. David Sugianto
memperkenalkannya untuk anda.

LAYAR WIZARD
Tampilan wizard akan muncul
ketika anda menjalankan pro-
gram L0pthcrack. Jika anda
ingin agar layar wizard selalu
muncul, silahkan langsung klik
Next.

SUMBER PASSWORD
L0pthcrack mendapatkan pass-
word yang akan di-crack dari
empat macam sumber: local
machine, remote machine, NT
4.0 repair disk, dan hasil sniffing
pada network. Kali ini kita
coba pilihan pertama.
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3 MEMBUAT DOKUMEN EXCEL

Buka apliksi Microsoft Excel dengan
memilih Start → Programs →
Microsoft Excel. Bila bidang kerja
Microsoft Excel telah tampil, buat
saja sembarang dokumen Excel
untuk percobaan.

NeoTutorNeoTutor

embuat password merupakan
solusi yang jitu untuk mence-
gah orang-orang yang tidak ber-

kepentingan mendapatkan informasi
dari dokumen yang telah kita simpan.

Rasa was-was akan terbongkarnya data-
data penting pada dokumen kita menye-
babkan kita sering kali mengganti-ganti
password. Namun tidak jarang upaya
proteksi itu malah menjadi bumerang
bagi kita sendiri yaitu jika kita lupa akan
password yang telah masukkan pada
dokumen yang kita buat tersebut.

Kali ini penulis akan menjelaskan satu
cara untuk mengetahui password pada
dokumen kita sendiri. Tujuannya hanya
satu yaitu mengembalikan password

ADADVVANANCCEED OD OFFFFIICCE 2000E 2000
PPAASSSWSWOORRD RD REECOCOVVEERRYY
MMEEMMUULILIHHKKAN PAN PAASSSWSWOORRDD
WWOORRD DD DAN EAN EXXCCEELL

PASSWORD LENGTH OPTIONS

Kotak “Brute-force options” mempu-
nyai dua bagian yaitu Password Length
dan range options. Pada kotak Pass-
word length options, pastikan Minimal
length-nya berisi '1' dan Maximal length-
nya berisi '4', yang merupakan nilai
tertinggi untuk versi trial ini. 

BRUTE-FORCE RANGE OPTIONS

Kursor akan berpindah ke offset
28172 yang merupakan awal tu-
lisan Log Off yang dimaksud. Tulis-
an memanjang dari offset 28172
sepanjang F h offset. Inilah yang
akan kita ganti. 

MEMBUAT DOKUMEN WORD
Buka aplikasi Microsoft Word
dengan memilih Start → Programs
→ Microsoft Word. Setelah bidang
kerja jendela Microsoft Word tam-
pil, buatlah sembarang dokumen
Word untuk percobaan.

MEMASANG PASSWORD TO
OPEN DI WORD
Selanjutnya pilih File → Save As.
Lalu pilih Tools → General Options.
Isikan kata “pass” pada bagian ‘Pass-
word to Open’ dan tekan tombol
Ok. Isikan lagi kata “pass” pada
kotak dialog “Confirm Password.”
Simpan dokumen Word tersebut.

1
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DITEMUKAN!
Proses pencarian password
berlangsung beberapa lama. Dan
bila ditemukan akan tampil kotak
dialog statistik. Pada baris keem-
pat di kotak “Password for this
file” akan berisi password untuk
dokumen Word ini yaitu “pass.”

JUGA PADA DOKUMEN EXCEL

Ulangi langkah 6 sampai 10 un-
tuk dokumen Excel. Bila berhasil
akan tampil kotak dialog yang akan
memberitahukan password doku-
men tersebut yaitu “piss.” Anda
dapat bereksperimen dengan
dokumen yang lain.

MEMASANG PASSWORD TO
OPEN DI EXCEL
Kemudian pilih File → Save As, dan
lanjutkan dengan Tools → General
Options. Pada  Save Options, isikan
“piss” pada  “Password to Open.”
Tekan OK dan isikan lagi kata
“piss” pada Confirm Password.
Simpan dokumen Excel tersebut.

THE SHOW BEGINS
Jalankan aplikasi Advance Office
2000 Password Recovery yang
telah Anda instal dengan memilih
menu Start → Programs →
Advanced Office 2000 Password
Recovery → Advanced Office 2000
Password Recovery. 
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Praktik memulihkan password pada dokumen Word dan Excel.

MEMULAI PENCARIAN
Setelah semua setting-nya siap,
anda dapat langsung memulai
pencarian password. Gunakan
menu Recovery → Start. Lama
pencarian password tergantung
dari panjang password dan pilihan
jangkauannya.

9

PILIH DOKUMEN WORD
Pilihlah dokumen Word yang
terproteksi password yang telah
anda buat pada Langkah 1 dan 2.
Anda cukup mengklik ikon folder
pada kotak “File Name.” Pada kotak
dialog “Open,” cari file dokumen
Word tersebut.

6

HELP!
Kurang jelas? Atau ingin tahu le-
bih jauh tentang keandalan pro-
gram ini? Anda dapat memanfa-
atkan file bantuannya dengan
memilih menu Help → Help
Contents. Ingin tahu lebih jauh
lagi? Kunjungi situs Web-nya.

12

kita yang hilang yang kebanyakan di-
sebabkan oleh karena anda lupa akan
password itu.

Program yang digunakan untuk tujuan
ini adalah Advanced Office 2000 Pass-
word Recovery. Program ini bekerja de-
ngan metode Brute Force. Dengan meto-
de ini, Advanced Office 2000 melaku-
kan pencarian password dengan mem-
bandingkannya pada kombinasi teks
yang terbentuk dari karakter-karakter.

Biasanya Brute Force membutuhkan
waktu lama sebab menggunakan semua
kombinasi yang mungkin untuk mem-
bentuk password dari karakter-karakter
yang ada.

Versi un-registered program Advanced
Office 2000 Password Recovery bisa
diperoleh gratis dari Elcomsoft
(www.elcomsoft.com/ao2000pr.html.)
atau dari CD NeoTek bulan ini.

Aplikasi ini kemudian dapat anda instal
di komputer anda. Setelah itu anda dapat
menggunakannya untuk memulihkan
atau mencari kembali password yang
telah anda masukkan pada dokumen
Office anda dan anda telah lupa. Pada
artikel ini akan dipraktikkan cara me-
mulihkan “Password to Open” untuk
dokumen Microsoft Word dan Excel.

Apabila ada pertanyaan, penulis dapat
dihubungi di hchandraleka@telkom.net

M

• Advanced Office 2000 Password Recovery dapat
diperoleh di www.elcomsoft.com/ao2000pr.html

atau pada CD Neotek bulan ini.

Kebiasaan gonta-ganti password kadang menjadi bumerang
bagi kita sendiri. Happy Chandraleka menguraikan cara
mengatasi password yang terlupa lewat artikel di bawah ini.
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3 MEMBERI PASSWORD
Pada kotak dialog “Add” tersebut,
selanjutnya tekan tombol “Pass-
word” di pojok kanan bawah. Kotak
dialog “Password” akan tampil.
Isikan kata 'sandi' pada kotak
Password dan tekan tombol OK.
Ulangi pengisian pada kotak dialog
yang tampil dan tekan OK.

NeoTutorNeoTutor

etelah dijelaskan cara memulih-
kan password yang terlupakan
pada dokumen Microsoft Office,

kali ini disajikan cara mendapatkan kem-
bali password yang terlupakan pada file
dokumen lain di luar Microsoft Office,
dengan menggunakan program Advan-
ced Archive Password Recovery.

Seperti Advanced Office 2000 Password
Recovery, program ini pun adalah pro-
duk dari Elcomsoft dan versi unregist-
ered-nya dapat di-download gratis lewat
situs Elcomsoft (www.elcomsoft.com/
archpr.html) atau didapatkan dari CD
NeoTek bulan ini.

Program ini pun menggunakan metode
Brute-Force dalam operasinya. Pada ba-

ADADVVANANCCEED ARD ARCCHHIIVVEE
PPAASSSWSWOORRD RD REECOCOVVEERRYY
MMEEMMUULILIHHKKANAN
PPAASSSWSWOORRD WD WIINNZZIIP P 

MENENTUKAN FILE
Tentukan file yang akan dicari pass-
word-nya. Anda cukup menekan ikon
folder pada kotak Encrypted ZIP/
RAR/ACE/ARJ—file. Kotak dialog
“Open” akan tampil. Carilah file yang
terproteksi password tersebut.

MENENTUKAN RANGE
Pada tab “Range,” tentukan pilihan
opsinya. Pilihan opsi ini menentu-
kan kecepatan dan akurasi program
dalam mencari password. Pilih saja
opsi “All Small.” Bisa saja anda me-
milih opsi “All printable,” tetapi
akan memakan waktu yang lama.

FILE KELINCI PERCOBAAN
Copy-kan beberapa file percobaan
ke direktori “My Documents.” Pada
contoh ini di-copy-kan beberapa
file bitmap dari direktori Windows.
Sorot seluruh file tersebut dan klik
kanan kemudian pilih menu “Add
to Zip.”

KOTAK DIALOG ADD
Akan tampil kotak dialog “Add.”
Pada kotak “Add to archive,” beri
nama filenya dengan “File Terpro-
teksi Password,” sehingga lengkap-
nya menjadi “C:\My Documents\
File Terproteksi Password.” Biarkan
pilihan-pilihan lainnya.
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MEMULAI PENCARIAN
Setelah semua setting siap, anda
dapat memulai pencarian pass-
word dengan menekan tombol
“Start” yang berwarna biru pada
toolbar aplikasi. 

PROSES PENCARIAN
Proses pencarian password akan
berlangsung beberapa waktu,
bergantung pada panjang pass-
word-nya dan pilihan jangkauan
Brute-Force. Anda dapat meman-
tau proses pencarian yang diperli-
hatkan pada “Status Window.”

PROSES PENGEPAKAN
Kemudian tulisan di title bar akan
berganti dengan “Add with Pass-
word.” Lanjutkan proses dengan
menekan tombol “Add” di pojok
kanan atas. Winzip akan melakukan
proses pengepakan. Setelah selesai,
di akhir nama file akan terdapat
tanda plus.

FILE TERPROTEKSI PASSWORD
Buka jendela Windows Explorer
dan anda akan melihat hasil file
zip-nya pada direktori “My Docu-
ments.” File ini diproteksi dengan
password yang akan dicari dengan
Advanced Archive Password
Recovery.
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Praktik memulihkan password yamg hilang pada archive file

PASSWORD LENGTH
Pada tab “Length”, tentukan juga
panjang minimal dan maksimal
password-nya. Untuk minimal,
isikan nilai '1' dan untuk maksi-
mal, isikan nilai '5', yang merupa-
kan nilai tertinggi untuk versi
unregistered ini.
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JALANKAN ADVANCED
ARCHIVE PASSWORD
RECOVERY
Jalankan program Advanced Archive
Password Recovery dari Start menu
kemudian Programs → Advanced
Archive Password Recovery →
Advanced Archive Password
Recovery.

6

INI DIA PASSWORD-NYA!
Proses pencarian berakhir dengan
tampilnya kotak dialog yang mem-
beri informasi mengenai statistik
pencarian. Pada baris keempat
tabel statistiknya diperlihatkan
password untuk untuk file ini
yaitu “sandi.”

12

gian terdahulu sudah dijelaskan, karena
cara kerjanya, Brute-Force kadang kala
membutuhkan waktu lama untuk bisa
menyelesaikan pekerjaannya yaitu mem-
peroleh password yang anda cari.

Untuk menjelaskan cara kerja Advanced
Archive Password Recovery, pada arti-
kel ini dipraktikkan cara kerjanya men-
dapatkan kembali password pada se-
buah file percobaan yang dibuat dengan
menggunakan utilitas kompresi yaitu
WinZip.

Anda sudah tentu dapat menggunakan
utilitas pencari password ini untuk do-
kumen-dokumen yang dibuat dengan
program lain. Dan seperti yang anda

akan jumpai pada artikel ini, penggu-
naan Advanced Archive Password
Recovery ini sederhana dan mudah.

Apabila ada pertanyaan mengemai
artikel ini, penulis dapat dihubungi di
hchandraleka@telkom.net

S

• Advanced Archive Password Recovery dapat
diperoleh di www.elcomsoft.com/archpr.html atau

pada CD NeoTek bulan ini.

Lupa password yang anda berikan pada file winzip yang anda
buat? Happy Chandraleka memberi jalan keluar dengan
utilitas Advanced Archive Password Recovery.
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ALAH SATU FASILITAS YANG MENARIK pada Outlook
Express (OE) sejak versi 5.0 adalah Multiple Ident-
ities, dimana dengan fasilitas tersebut setiap pema-

kai dapat mengkonfigurasikan program OE pada identitas-
nya masing-masing. Konfigurasi yang dimaksud meliputi
tampilan (view), account, dan lain-lain.

Selain itu, seorang pemakai dapat menambahkan password
pada identitasnya, sehingga jika pemakai akan memasuki
identitas tersebut akan ditanyakan password terlebih dahulu.

Hal ini dimaksudkan jika pemakai tersebut ingin menam-
bahkan faktor keamanan sehingga e-mail-nya tidak dibaca
dan/atau account-nya tidak di-copy oleh orang lain.

Namun, salah satu kekurangan program OE ini adalah jika
pemakai tersebut lupa melakukan log off, maka ketika pro-
gram OE dijalankan lagi akan langsung menuju pada iden-
titas terakhir sekalipun pada identitas tersebut terpasang
password.

Dengan demikian, kunci untuk menerobos masuk pada
suatu identitas yang terpasang password adalah membuat
seolah-olah sang pemakai lupa melakukan log off pada
identitas tersebut.

Melakukan hal tersebut ternyata cukup mudah, yaitu de-
ngan memanfaatkan Registry Editor (regedit). Dibawah ini
dibahas langkah-langkahnya.

Menembus PMenembus Passwassworord Id IDD
pada Outlook Express pada Outlook Express 

Produk-produk dalam lingkungan Microsoft Office memang kurang tangguh pengamanannya.
Setelah membahas betapa mudahnya mendapatkan password file Access dengan Cain

dan password-password  Word dan Excel dengan produk-produk Elcomsoft,
kini Fitrianto Halim membahas betapa lemahnya pengamanan pada Outlook Express.

S

Jika anda telah log off, maka nilai registry-nya sama dengan yang diperlihatkan pada gambar di atas. Dari hasil
percobaan, untuk menerobos masuk pada suatu identitas yang terpasang password adalah cukup dengan meng-
ganti nilai Last User ID dengan ID yang anda inginkan.

1

Untuk mendapatkan ID yang anda inginkan, anda dapat mencarinya pada subkey dari Identities seperti yang
terlihat pada gambar di bawah ini.2

Untuk memudahkan penggantian nilai Last User ID, anda dapat melakukan Copy/Paste, seperti terlihat pada
gambar-gambar di bawah ini.3

KKeessiimmppuullaann

Keamanan pada OE 5.x tidak baik. Oleh karena itu, jangan
menyimpan password pada account anda, agar account
anda tersebut tidak disalahgunakan oleh orang lain.

Apabila ada pertanyaan megenai artikel ini maupun
artikel lainnya mengenai Outlook Express, hubungi
penulis di fitriantoh@hotmail.com
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Tip Lain Seputar Outlook ExpressTip Lain Seputar Outlook Express
Dimana folder
Outlook Express 5.x disimpan?
Ada cara mudah untuk mengetahui
dimana folder Outlook Express 5.X
(OE) disimpan.

Pertama-tama masuk ke Folder
List. Caranya, pada menu
View pilih Layout...

Kemudian, aktifkan Folder
List (ditandai dengan adanya
tanda centang).

Pilih folder yang akan dilihat
(misalnya Outbox); lihat
property-nya (misal dengan
menekan Alt+Enter).

Kini terlihat tempat folder ter-
sebut disimpan pada This
folder is stored in the
following file:

Memanfaatkan “Move to Folder”
dan “Copy to Folder”
Pada menu Edit kita akan menemu-
kan pilihan Move to Folder... dan
Copy to Folder...

Mungkin anda bertanya-tanya, apa
kegunaannya. Maka jawabannya
adalah bergantung pada kreativitas
anda.

Misalkan anda
ingin membuat
beberapa surat

lamaran kerja dan dikirim
lewat email, maka anda
cukup membuat sebuah
draft lalu manfaatkan Copy
to Folder... untuk meng-
copy draft tersebut.

Kini, anda hanya perlu
mengedit sedikit email
tersebut.

Sedangkan Move to Folder...
dapat Anda manfaatkan untuk
sinkronisasi email. Misalkan

anda memiliki komputer dengan Out-
look Express 5.x, tetapi tidak
memiliki koneksi ke Internet.

Jika anda sudah memiliki account
email jenis POP3 (atau yang mirip

POP3, yaitu account dari Hot Mail),
maka email yang anda terima di warnet
dapat anda baca pula di rumah.

Caranya, setelah selesai men-download
email, “pindahkan” isi yang ada pada
Local Folders\Inbox (Hotmail\Inbox
untuk HotMail) ke folder yang tidak
terpakai (misal, Local Folders\Drafts).

Setelah keluar dari OE, copy file
Drafts.DBX ke disket.

Di rumah, copy file Drafts DBX yang
berasal dari disket ke harddisk anda.
Setelah OE dijalankan, masuk ke
Local Folders\Drafts lalu “pindahkan”
isinya ke Local Folders\Inbox.

Kini anda dapat membaca e-mail  yang
anda download di Warnet dengan
tenang di rumah.

Utak-atik Header email
Outlook Express
Umumnya, orang mengirim anonymous
mail melalui telnet, itupun coba-coba.

Pada trik ini, kita akan mencoba meng-
utak-atik header email dengan cara
yang gampang, dengan email yang
dibuat dengan Outlook Express 5.x.

Secara garis besar, folder-folder yang
ada pada OE akan dinyatakan sebagai
sebuah file DBX. File ini berisi index
dan isi. Nah, bagian isi adalah bagian
yang terpenting, karena bagian ini
yang akan dikirim ke SMTP server.

File kuncinya adalah Outbox.DBX.
Untuk mengutak-atik header-nya anda

membutuhkan suatu editor yang mam-
pu mengedit data binary (penulis sen-
diri menggunakan Norton Utilities).

Ada baiknya, anda memadatkan file
Outbox.DBX terlebih dahulu dengan
memilih menu File → Folder →
Compact (Anda sedang berada di
folder Outbox).

Header awal dari OE adalah From,
sehingga jika editor yang anda pakai
menyediakan fasilitas search, anda
dapat mengisikannya dengan From:
sebagai kata yang dicari.

Silahkan berkreasi... Sebagai contoh, pe-
nulis paling suka mengosongkan header
Date (akan diisi oleh SMTP server) dan
mengganti header X-Mailer.

Ada baiknya anda membuat back-up
terlebih dahulu.

Mengubah Letak Penyimpanan
Folder-folder Outlook Express 5.x
Folder-folder pada Outlook Express
5.x disimpan pada file-file DBX yang
bersesuaian dengan nama  folder-nya.
File-file tersebut secara default akan
terdapat pada C:\WINDOWS\ Appli-
cation Data\Identities\ID Anda\
Microsoft\Outlook Express\

Untuk mengubahnya, kita menggu-
nakan registry editor (regedit).

Pertama-tama, masuklah ke
HKEY_ CURRENT_USER\
Identities. Pada key Identities,
anda akan mendapatkan satu

atau lebih subkey (tergantung pada ba-
nyaknya identitas yang ada) yang berisi
ID. Dari subkey inilah, anda dapat me-
lihat identitas yang sesuai.

Expand subkey tersebut
hingga anda menuju
HKEY_ CURRENT_USER\
Identities ID Anda\Software\

Microsoft\ Outlook Express\5.0
(Di sini penulis menggunakan OE 5.0).

Pada bagian kanan, cari name Store
Root yang berisi letak penyimpanan
folder-folder pada OE.

Ganti isinya sesuai kehendak anda,
misal C:\My Documents\My Mails\

Manfaat dari artikel ini akan terasa
jika anda bekerja pada network, kare-
na anda tidak perlu lagi meng-copy
file-file DBX milik rekan anda.

Animasi Slide
pada Outlook Express
Jika anda senang mengutak-atik Java
Script, mungkin anda pernah mem-
buat animasi slide, artinya gambar
bisa berpindah sendiri dalam rentang
waktu tertentu.

Tapi, bagaimana jika kita ingin me-
nampilkan animasi slide pada Out-
look Express 5.x dan dapat disajikan
secara offline?

Ternyata, cara membuatnya tidak su-
kar jika anda pernah mempelajari
teknik penyatuan teks dan gambar
yang ada pada OE—disebut Stationery.

Kuncinya adalah header content-type
utama diisi dengan multipart/related
dan tiap-tiap gambar memiliki header
content-id yang unik. Isi dari header
content-id inilah yang digunakan se-
bagai pengganti nama file gambar.

Apakah sudah cukup? Masih belum,

karena semua gambar harus ditam-
pilkan. Sebab jika anda tidak melaku-
kannya, maka gambar-gambar yang
tidak ditampilkan akan dianggap
sebagai attachment. Agar gambar-
gambar tersebut tidak tampak, maka
anda dapat mengatur atribut height
dan width dari tag img ke 0.

Penulis sarankan untuk mencobanya
dalam format EML (Microsoft Internet
Mail Message). Sebagai tambahan,
format EML sebenarnya berupa plain
text, sehingga anda dapat mengedit-
nya dengan text editor.

Untuk menampilkannya, ada bebera-
pa cara yang bisa digunakan.

Pertama, anda bisa menyimpan isi EML
tersebut ke e-mail dalam format plain
text (default dari isi header Content-
Transfer-Encoding adalah 7 bit).

Kedua, Anda bisa menyisipkan file
EML tersebut.

Tentunya, kedua cara tadi masih me-
merlukan revisi header dari e-mail
tersebut (lihat artikel terakhir).

Sebagai contoh, anda dapat melihat
file “Happy Birthday.EML” yang
disertakan.

Di sini anda dapat melihat sebuah
foto album sederhana. Pada contoh
ini, hanya sebuah format yang
didukung, yaitu text/html.

1

1

2

1

2

2
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Cara kerja:
Pertama kali statement while akan menguji kondisi dari ekspresi
yang diberikan, jika kondisi terpenuhi maka statement-
statement dalam blok akan diekseskusi. Kemudian nilai
variabel konter akan dinaikkan pada bagian akhir blok.

Selanjutnya statement while akan memeriksa kembali kondisi,
apakah masih terpenuhi? Jika ternyata masih terpenuhi maka
statement-statement dalam blok akan kembali dieksekusi,
sebaliknya jika sudah tidak terpenuhi maka perulangan akan
dihentikan. Demikian proses ini terjadi berulang-ulang sampai
kondisi yang disyaratkan tidak lagi terpenuhi.

Contoh:
Berikut (contoh 5.3) adalah contoh script yang menggunakan
perulangan dengan statement while.

Keterangan:
Contoh di atas akan memberian hasil yang sama dengan
contoh perulangan dengan menggunakan statement for.
Bandingkan hasilnya dengan Contoh 5.1!

Statement do … while 
Pada dasarnya perulangan dengan statement do … while sama
saja dengan perulangan yang menggunakan statement while.
Perbedaannya terletak pada letak dari kondisi yang diuji.

Pada statement do … while, kondisi ditempatkan pada akhir
perulangan, sedangkan pada statement while kondisi dile-
takkan pada awal perulangan.

Konsekuensinya, pada statement do … while, akan terjadi
minimal sekali proses eksekusi terhadap blok statement, mes-
kipun kondisi awal tidak terpenuhi.

Sebaliknya pada statement while dimungkinkan tidak
adanya eksekusi sama sekali terhadap blok statement, karena
pemeriksaan dilakukan di awal.

Sintaksnya sebagai berikut:

Contoh:
Berikut adalah Contoh 5.1 yang dimodifikasi dengan
menggunakan statement do … while.

Statement break
Statement break digunakan untuk menghentikan perulangan
meskipun secara kondisional perulangan masih harus
dilakukan. Perhatikan contoh berikut:

Keterangan:
Pada contoh di atas perulangan akan dihentikan pada saat nilai
variabel x mencapai nilai 4. Artinya perulangan hanya akan
dilakukan sebanyak tiga kali.

Statement continue
Statement continue digunakan untuk mengarahkan proses
eksekusi kembali ke awal proses perulangan, tanpa mengek-
sekusi statement-statement di bawahnya.

<!-- contoh 5.3 -->

<!-- simpan dalam format html -->
<html>
<head>
<title>Perulangan dengan statement while</title>
</head>
<body>
<script language="javascript">
<!--
var x
x=1
while(x<8)
{
document.write("<font face=\"arial\" size=\""+ x +"\">Javascript")
document.write("</font><br>")
x++
}
//-->
</script>
</body>
</html>

do
{
---statement javascript
---statement javascript
---statement javascript
variabel konter
}
while(kondisi yang di uji)

<!-- contoh 5.4 -->
<!-- simpan dalam format html -->
<html>
<head>
<title>Perulangan dengan statement do … while</title>
</head>
<body>
<script language="javascript">
<!--
var x
x=1
do
{
document.write("<font face=\"arial\" size=\""+ x +"\">Javascript")
document.write("</font><br>")
x++
}
while(x<8)
//-->
</script>
</body>
</html>
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erulangan adalah pengeksekusian secara berulang
terhadap kelompok statement sebanyak yang
ditetapkan. Prinsip perulangan sering digunakan,

karena dapat mengurangi panjang listing program, sehingga
penulisan scripting lebih efektif dan efisien.

Contoh kasus yang dapat diselesaikan dengan perulangan
banyak sekali, misalnya saja perhitungan nilai faktorial, nilai
rataan sejumlah data, dan masih banyak lagi (lihat beberapa
contoh kasus pada akhir pembahasan).

Dalam javascript, alur perulangan dapat dilakukan dengan
menggunakan:
1. Statement for
2. Statement while
3. Statement do... while

Statement for
Digunakan untuk melakukan proses perulangan yang telah
diketahui berapa kali jumlah perulangan yang akan
dilakukan. Sintaksnya sebagai berikut:

Keterangan:

a. Inisialisasi
Yaitu untuk memberi inisial terhadap variabel konter secara
sederhana dapat dikatakan sebagai nilai awal dari variabel
konter. Komponen ini merupakan kondisi awal dari proses dan
hanya akan dieksekusi sekali saja pada awal proses.

b. Kondisi
Yaitu untuk menentukan batas akhir dari perulangan, di mana
jika kondisi sudah tidak lagi terpenuhi, maka perulangan akan
dihentikan, sebaliknya jika kondisi masih terpenuhi maka per-
ulangan masih akan terus dilakukan.

c. Konter
Yaitu untuk menaikkan nilai variabel konter. Komponen ini
menjadi penting, karena penaikan nilai variabel konter terkait
dengan batas akhir dari proses perulangan. Jika variabel konter
nilainya tetap maka secara otomatis batas akhir tidak akan
pernah tercapai sehingga proses perulangan tidak akan pernah
berhenti.

Contoh penggunaan:

Contoh skrip yang menggunakan perulangan dengan for

Keterangan:
Pada contoh di atas, kita melakukan perulangan terhadap
penulisan kata Javascript dengan urutan besar font naik. Coba
jalankan di browser anda!

Catatan:
Jika dalam bagian komponen terdapat lebih dari satu statement
maka masing-masing statement dipisahkan dengan tanda
koma ( , ). Perhatikan contoh skrip berikut:

Keterangan:
Pada contoh di atas, output akan berupa bilangan ganjil dengan
penulisan yang semakin membesar. Coba di browser anda!

Statement while
Digunakan untuk perulangan yang hanya diketahui kondisi
akhir dari perulangan tersebut tanpa diketahui berapa kali
jumlah perulangan akan dilakukan. Sintaksnya sebagai berikut:

PPerulanganerulangan
Pada bagian kelima dari tutorial JavaScript ini kami memperkenalkan Perulangan. Perulangan membuat

penulisan program dengan JavaScript menjadi lebih efisien karena dengan fitur yang satu ini penulisan listing
program kadang tidak perlu diulang sehingga bisa lebih efektif dan efisien.

for(inisialisasi; kondisi; konter)
{
---statement javascript
---statement javascript
—-statement javascript
}

<!-contoh 5.1 -->

<!-- simpan dalam format html -->
<html>
<head>
<title>Perulangan dengan statement for</title>
</head>

<body>
<script language="javascript">
<!--
var x
for(x=1;x<8;x++)
{
document.write("<font face=\"arial\" size=\""+ x +"\">Javascript")
document.write("</font><br>")
}
//-->
</script>
</body>
</html>

Mengenal JavaScriptMengenal JavaScript

P

<!-- contoh 5.2 -->

<!-- simpan dalam format html -->
<html>
<head>
<title>Perulangan dengan statement for</title>
</head>
<body>
<script language="javascript">
<!--
var x,y
for(x=1;y=1,x<8;x++,y+=2)
{
document.write("<font face=\"arial\" size=\""+ x +"\">"+ y)
document.write("</font><br>")
}
//-->
</script>
</body>
</html>

while(kondisi yang diuji)
{
---statement javascript
---statement javascript
---statement javascript
variabel konter
}

<!-- contoh 5.5 -->

<!-- simpan dalam format html -->
<html>
<head>
<title>Statement break</title>
</head>
<body>
<script language="javascript">
<!--
var x
x=1
while(x<8)
{

if(x==4)
{
break
}

document.write("<font face=\"arial\" size=\""+ x +"\">Javascript")
document.write("</font><br>")
x++
}
while(x<8)
//-->
</script>
</body>
</html>
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Setelah tampilan form selesai kita buat, kini kita memer-
lukan sebuah file khusus yang berfungi untuk menyim-
pan data-data. Untuk itu, buka teks editor kesayangan
anda, ketikkan:

Simpanlah dengan nama data.txt.

Kini saatnya kita membuat halaman Web yang bertugas
menerima masukan dari pengunjung dan menyimpannya
ke file data.txt. Kodenya akan terlihat sebagai berikut:

Hasilnya akan seperti pada gambar di kolom sebelah atas.

Penjelasan file terima.asp:
<H2>Terima Kasih Atas Partisipasi Anda</H2><HR><p>
<center> Hasil Sementara Hingga Tanggal <%=date()%>
</center><p>

Skrip di atas berfungsi untuk menampilkan ucapan
terima kasih serta menampilkan tanggal hari ini yang
didapat dari fungi <%=date()%>

Dim objBuka, objFSO, Path, nilai(3), pilihan
Semua variabel yang akan digunakan di aplikasi polling
ini dideklarasikan

pilihan = Request.Form("polling")
Value hasil kiriman yang radio button yang dipilih
disimpan di dalam variable pilihan

Path = Server.MapPath("data.txt")
Set objFSO = Server.CreateObject("Scripting.FileSystemObject")
set objBuka = objFSO.OpenTextFile(Path, 1)
Kita menggunakan tiga variable, yaitu Path untuk
menyimpan lokasi file data.txt, objFSO yang merupakan
unsure yang harus diikutsertakan, dan yang terakhir
objBuka untuk membuka file data.txt dan men-setnya
menjadi mode “1”, yaitu mode membaca.
varA = 0
Do While varA < 3
nilai(varA) = objBuka.ReadLine
varA = varA + 1
Loop
Ini merupakan struktur kontrol perulangan ASP yang
kita gunakan untuk mengisi variable nilai yang bersifat
“array.” Karena kita hanya menggunakan tiga macam
pilihan, yaitu “html,” “asp,” dan “php,” maka perulangan
pun cukup sebanyak tiga kali. Dan dalam perulangan ini,
terdapat “objBuka.ReadLine” untuk membaca file per
baris dan disimpan ke dalam variabel nilai (indeksnya
mengikuti varA).
Select Case pilihan
Case "html" 

nilai(0) = nilai(0) + 1
Case "asp"

nilai(1) = nilai(1) + 1
Case "php"

nilai(2) = nilai(2) + 1
End Select
Jika di atas kita menggunakan struktur kontrol perulang-
an, kini kita menggunakan struktur kontrol perbandingan
dengan variable pilihan yang menjadi fokusnya. Ingat
pilihan didapat dari "pilihan=Request.Form("polling")"

Jumlah = nilai(0) + nilai(1) + nilai(2)

Tentunya kita ingin untuk menampilkan jumlah suara
yang telah ikut berpartisipasi di polling kita. Untuk itu,
kita menggunakan variable jumlah untuk menyimpan
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PLIKASI POLLING SERING SEKALI KITA TEMUKAN pada
halaman-halaman Web di Internet. Polling atau
jajak pendapat berguna untuk mengumpulkan

pendapat para pengunjung Web anda mengenai sesuatu
hal. Misalnya, anda ingin mencari tahu perbandingan
antara pengunjung situs anda yang berminat mempelajari
HTML, PHP, dan ASP. Setiap kali seorang pengunjung
memilih salah satu opsi, maka jumlah dari pilihan pada
opsi tersebut akan bertambah. Dan dengan nilai tersebut,
anda dapat melihat berapa persen atau suara yang berpar-
tisipasi, atau opsi mana yang paling diminati pengunjung.
Menarik bukan?

Jika selama ini anda mandapatkan fasilitas polling dari
situs portal yang menyediakan, anda sebenarnya dapat
membuatnya sendiri sesuai dengan keinginan dan keper-
luan anda. Dalam membuat artikel ini, saya berasumsi
bahwa anda telah menguasai atau memahami HTML
walaupun yang mendasar. Oleh karena itu, kode yang
tidak memerlukan skrip ASP, tidak saya bahas mengingat
ruang dan tempat. Dan untuk dasar ASP anda dapat
membacanya di majalah NeoTek edisi Mei 2002.

Marilah kita memulai pembuatan polling-nya. Pertama-
tama yang harus kita buat terlebih dahulu adalah tam-
pilan polling tersebut. Untuk itu, kita akan membuat file
pertama dengan nama form.asp. Sebenarnya, jika anda
ingin menggunkan nama file form.htm juga bisa, namun
untuk menyeragamkan, maka saya menggunakan nama
form.asp. Ketikkan skrip pada kotak di kolom sebelah ini
ke dalam teks editor kesayangan anda.

Kode-kode yang diberikan murni merupakan HTML
statis. Dalam kode tersebut kita membuat form dengan
menggunakan tag <form> yang diikuti oleh radio button
dengan tag  <input type=”radio”> dengan nama
“polling” dan value masing-masing yang berbeda satu
dengan yang lain.

Jika anda buka di browser, akan tampil gambar berikut:

A

Dengan FDengan Format Data File .txtormat Data File .txt

PPolling dengan Aolling dengan ASSPP
Polling adalah fitur yang dapat ditambahkan pada halaman Web anda. Fitur ini banyak manfaatnya

bagi anda sebagai pengelola situs. David Sugianto menyajikan cara membuat fasilitas polling
atau jajak pendapat sendiri sehingga lebih sesuai dengan keperluan anda.

<html>
<head>      <title>Fasilitas Polling</title>
</head>
<body>
<form method="POST" action="terima.asp"> 

<p>Dari ketiga pilihan berikut ini, <br>          
manakah yang paling anda suka?</p> 

<p><input type="radio" value="html" checked
name="polling">HTML<br> 
<input type="radio" name="polling" value="asp">ASP<br>
<input type="radio" name="polling" value="php">PHP</p>
<p><input type="submit" value="Kirim" name="Kirim"></p>
</form>
</body>
</html>

<html><head>
<title>Fasilitas Polling</title>

</head><body>
<H2>Terima Kasih Atas Partisipasi Anda</H2><HR><p>
<center> Hasil Sementara Hingga Tanggal <%=date()%> </center><p>
<%

Dim objBuka, objFSO, Path, nilai(3), pilihan
pilihan = Request.Form("polling"
Path = Server.MapPath("data.txt")
Set objFSO = Server.CreateObject("Scripting.FileSystemObject")
set objBuka = objFSO.OpenTextFile(Path, 1)

varA = 0
Do While varA < 3
nilai(varA) = objBuka.ReadLine
varA = varA + 1
Loop

%>
<%

Select Case pilihan
Case "html"

nilai(0) = nilai(0) + 1
Case "asp"

nilai(1) = nilai(1) + 1
Case "php"

nilai(2) = nilai(2) + 1
End Select
Jumlah = nilai(0) + nilai(1) + nilai(2)

%><pre>
HTML  = <%=nilai(0)%>
ASP    = <%=nilai(1)%>
PHP    = <%=nilai(2)%>

Dengan Jumlah = <%=jumlah%>
</pre>
<%

Set objFSO = Server.CreateObject("Scripting.FileSystemObject")
set objBuka = objFSO.OpenTextFile(Path, 2)
varA = 0
Do While varA < 3

objBuka.WriteLine nilai(varA)
varA = varA + 1

Loop
%>

</body></html>

0
0
0



Pada window Design View, isilah field-field yang akan
kita gunakan.

Simpan table tersebut dengan nama tbldata.

Setelah kita selesai dengan pembuatan database-nya, kini
kita akan mulai membuat halaman-halaman web yang
kita perlukan. Halaman yang kita akan buat terlebih
dahulu ialah halaman formnya yang juga akan menam-
pilkan jumlah suara telah yang masuk ke database kita

Ketikkan kode berikut ini ke dalam teks editor anda.

Simpanlah dengan nama form.asp. dan jika anda buka dari
browser, tampilannya akan seperti gambar di bawah ini:

Penjelasan singkat mengenai script ASP tersebut:

<!--#Include File=adovbs.inc-->
Jika kita berhubungan dengan basisdata, maka file
adovbs.inc harus diikutsertakan. Karena file ini berisi
konstanta yang diperlukan oleh metode ADO. File ini
dapat anda temukan di C:\program Files\Common
Files\System\ADO

Path = Server.MapPath("Polling.mdb")
Pada statement ini, kita menentukan lokasi dari basisdata
Access yang telah kita buat dan disimpan ke dalam
variabel Path.

strSQL = "SELECT * FROM data"
Select merupakan perintah dari SQL yang berfungsi
membaca baris per baris. Kerena kita menggunakan
karakter *, maka dianggap kita membaca seluruh baris
yang ada di tabel data
Set objConn = Server.CreateObject("ADODB.Connection")
objConn.Open "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=" &
filePathSet 
objRset = Server.CreateObject("ADODB.Recordset")
objRset.Open strSQL, objConn, adOpenStatic
Kini kita harus membuka koneksi ke basisdata agar isi
dari basisdata dapat kita manipulasi baik membaca,
menambah, meng-update, dan sebagainya.
Response.Write objRset.RecordCount & " Suara"
Jika anda mengikuti artikel tentang ASP dari pertama,
maka anda pasti mengetahui bahwa fungsi Response.Write
digunakan untuk menampilkan ke layar monitor. Sedang-
kan objRset.RecordCount & "Suara" untuk menghitung jumlah
record yang tersimpan dalam basisdata kita, yang diikuti
dengan kata "Suara"
ObjRset.Close
Set ObjRset = Nothing
objConn.Close
Set objConn=Nothing
Blok skrip di atas berfungsi untuk menutup basisdata
yang telah kita buka.

Kini saatnya kita membuat halaman yang terakhir, yaitu
halaman yang mengucapkan terima kasih kepada pengun-
jung dan bertugas untuk memasukkan data ke dalam
basisdata kita. Ketikkan kode berikut ini di dalam teks
editor kesayangan anda.
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jumlah dari variable nilai dari semua indeks.

<pre> 
HTML  = <%=nilai(0)%> 
ASP   = <%=nilai(1)%> 
PHP   = <%=nilai(2)%>

Dengan Jumlah = <%=jumlah%>
</pre>
Merupakan perintah/tag HTML biasa yang digabung
dengan kode ASP untuk menampilkan status pilihan dan
jumlah seluruh suara.

Set objFSO = Server.CreateObject("Scripting.FileSystemObject")
set objBuka = objFSO.OpenTextFile(Path, 2)
Jika waktu pertama kali kita membuka file data.txt
dengan mode membaca (“1”), maka kini kita membuka
file tersebut kembali namun dengan mode menulis (“2”).
Karena kita akan mengupdate file penyimpan data kita.

varA = 0
Do While varA < 3

objBuka.WriteLine nilai(varA)
varA = varA + 1

Loop
Langkah terakhir yang harus dilakukan adalah menuliskan
isi dari variabel nilai yang telah kita lakukan pertambahan
data/nilai. Dengan menggunakan perulangan dan"objBuka.WriteLine"
untuk menuliskan di file data kita per baris.

Kini anda telah selesai dalam membuat fasilitas Polling
yang dapat anda masukkan ke dalam halaman Web anda.
Semua nama variabel yang digunakan di atas, tidaklah
mutlak. Maksudnya jika anda berniat untuk mengganti
nama variabel-variabel di atas, silakan saja. Namun harap
hati-hati dalam mengganti namanya. Karena jika satu
variabel diganti, maka semua variabel yang namanya sa-
ma juga harus diganti.

olling merupakan suatu fasilitas yang biasanya
disediakan oleh para webmaster dari suatu situs
untuk mengetahui pendapat dari para pengun-

jung situs atas suatu hal. Jika pada artikel sebelumnya,
kita telah membuat fasilitas polling dengan menggunakan

file yang berbentuk *.txt sebagai bentuk penyimpanan
data, kini kita akan membuat fasilitas polling dengan
menggunakan basisdata dari Microsoft Access untuk
menyimpan data. Untuk itu, kita memerlukan file
database dari MS Access dengan cara pembuatannya 

DDengan Fengan Format Data Accessormat Data Access
P

Buka Ms.Access anda, lalu pada File > New, pilih
“Blank Access database.”1 Simpanlah dengan nama “Polling,” lalu klik

“Create.”2

Double klik "Create Table in Design View"3

FFiieelldd  NNaammee DDaattaa  TTyyppee

no AutoNumber
html Number
asp Number
php Number

<html><head>
<title>Fasilitas Polling</title>
</head>
<body> 

<!--#Include File=adovbs.inc-->
<table border="0" width="100%">

<tr> 
<td>Dari ketiga pilihan berikut ini, <br>

manakah yang paling anda sukai?<br>
<form method="POST" action="voting.asp"> 

<input type="radio" value="html" checked name="polling">HTML<br>
<input type="radio" name="polling" value="asp">ASP<br>
<input type="radio" name="polling" value="php">PHP<br>
<input type="submit" value="Kirim"><br>
Total:

<%
filePath = Server.MapPath("Polling.mdb")
strSQL = "SELECT * FROM data"
Set objConn = Server.CreateObject("ADODB.Connection")
objConn.Open "Provider=Microsoft.Jet.OLEDB.4.0;Data Source="
& filePath
Set objRset = Server.CreateObject("ADODB.Recordset")
objRset.Open strSQL, objConn, adOpenStatic
Response.Write(objRset.RecordCount & " Suara")
ObjRset.Close
Set ObjRset = Nothing
objConn.Close
Set objConn = Nothing
%>

</font></form></td></tr></table>
</body></html>

<html><head>
<title>Fasilitas Polling</title>
</head>
<body><center>
<H2>Terima Kasih Atas Partisipasi Anda</H2><HR
<H2>Hasil Sementara Hingga Tanggal <%=date()%></h2>
</center>
<!--#Include File=adovbs.inc-->
<%dim objConn, objRset, array(3)
dim Path, total, field(3), persen(3)
array(0) = "html"
array(1) = "asp"
array(2) = "php"
pilihan = Request.Form("polling")
Path=Server.MapPath("Polling.mdb")
Set objConn = Server.CreateObject("ADODB.Connection")
objConn.Open "Provider=Microsoft.Jet.OLEDB.4.0;Data Source="
+ Path
set objRset = Server.CreateObject("ADODB.Recordset")
objRset.Open "data", objConn, adOpenStatic, adLockOptimistic, adCmdTable
objRset.AddNew
Select Case pilihan



Simpanlah dengan nama voting.asp.

Dan hasilnya di browser akan seperti berikut 

Penjelasan singkat mengenai kode ASP di atas:
array(0) = "html"
array(1) = "asp"
array(2) = "php"

Kita menggunakan variabel array yang terdapat tiga
indeks, dan mengisi masing-masing indeks dengan
"html," "asp,""php"

pilihan = Request.Form("polling")
Untuk menerima value dari form yang dikirimkan dan
disimpan di variabel pilihan

objRset.AddNew
Select Case pilihan

Case "html"
objRset("html")=1

Case "asp"

objRset("asp")=1
Case "php"

objRset("php")=1
End Select

Skrip ini untuk memasukkan data ke dalam basisdata
dengan melakukan perbandingan terlebih dahulu
terhadap variabel pilihan.

For a=1 to total
For b=1 to 3

field(b)=field(b)+objRset(b)
Next

objRset.MoveNext
Next

For merupakan struktur kontrol perulangan dalam ASP,
yang kali ini kita gunakan untuk mengisi field-field yang
kita punya dengan jumlah dari data yang ada dalam field
tersebut. Field(1) mewakili html, field(2) mewakili asp,
dan field(3) mewakili php

For a=1 to 3
persen(a) = (field(a)/total)*100

Next

Jika tadi kita mengisi jumlah masing-masing field, kini
kita akan menghitung persentase dari field-field yang ada.
<pre>
HTML = <%=field(1)%>  (<%=int(persen(1))%>%)
ASP   = <%=field(2)%>  (<%=int(persen(2))%>%)
PHP   = <%=field(3)%>  (<%=int(persen(3))%>%)

Dari = <%=total%> Suara
</pre>

Dan terakhir kita menampilkan data masing-masing field
beserta keterangan, persentase, dan jumlah seluruh suara
yang ada di basisdata kita.

Kini anda telah membuat fasilitas polling sendiri dengan
memanfaatkan Microsoft Access sebagai media penyim-
panan data. Setiap metode, baik penyimpanan melalui
teks maupun basisdata memiliki kekurangan dan kele-
bihan masing-masing. Andalah yang menentukan sendiri
apakah lebih baik menggunakan teks atau basisdata.
Halaman Web yang telah kita buat di atas, dapat anda
ubah sesuai dengan kebutuhan anda. Selama tidak
mengganggu skrip ASP-nya.

Jika ada pertanyaan seputar tutorial ini anda dapat
mengirim email ke david_sugianto2002@yahoo.com
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Case "html"
objRset("html")=1

Case "asp"
objRset("asp")=1

Case "php"
objRset("php")=1

End Select
objRset.Update
total = objRset.RecordCount
objRset.MoveFirst

For a=1 to total
For b=1 to 3

field(b)=field(b)+objRset(b)
Next

objRset.MoveNext
Next

For a=1 to 3
persen(a) = (field(a)/total)*100

Nex
t%>
<pre>
HTML = <%=field(1)%>  (<%=int(persen(1))%>%)
ASP   = <%=field(2)%>  (<%=int(persen(2))%>%
)PHP  = <%=field(3)%>  (<%=int(persen(3))%>%)
Dari = <%=total%> Suara
</pre></body></html>
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IKA PADA EDISI SEBELUMNYA KAMI telah memperke-
nalkan pada anda salah satu perangkat lunak ber-
tajuk Remote Administration System yang sangat

“vulgar” dan bersifat user friendly, yaitu NetBus, rasanya
kurang sreg jika kami tidak menyertakan aplikasi sejenis
sebagai pelengkapnya. Hal ini kami lakukan karena kami
menyadari bahwa tidak semua software mampu meng-
handle semua yang kita inginkan, secanggih apa pun suatu
software, pasti memiliki kelemahan dan kekurangan. Nah,
agar “perangkat hacking” anda makin lengkap, anda perlu
mencoba dua buah perangkat hacking yang akan kami
bahas dalam artikel ini, yakni Back Orifice dan Deep Back
Orifice.

Back Orifice dan Deep Back Orifice adalah dua buah apli-
kasi berbasis client/server yang dapat dijalankan pada
sistem operasi UNIX dan Microsoft Windows 95/97/98/
ME/2000/XP, atau NT. Jika sebelumnya dikatakan bahwa
NetBus beroperasi pada port 12345 dan port 20034, maka

Back Orifice dan Deep Back Orifice beroperasi pada port
31337, inilah salah satu alasan yang membuat kami merasa
perlu untuk memperkenalkannya pada anda. Tentunya se-
makin banyak alternatif nomor port yang bisa disusupi,
maka akan semakin besar pula kemungkinan anda berhasil
melakukan hacking.

Sama seperti program Remote Administration System
lainnya, kedua buah aplikasi ini (Back Orifice dan Deep
Back Orifice) juga dilengkapi dengan sebuah program yang
berfungsi untuk menjembatani client agar dapat masuk
dan mengakses semua sumber daya pada komputer lain,
yang dalam hal ini disebut sebagai “server,” yaitu
BOSERVE.EXE. Jika program tersebut sedang aktif di
komputer orang lain, maka dapat dipastikan bahwa anda
akan leluasa mengakses semua isi hard disk komputer
orang lain tanpa mengalami kesulitan sedikit pun.

Dan satu hal lagi yang perlu anda ketahui dari kedua
aplikasi tersebut, jika BOSERVE.EXE sudah aktif di PC

BBO & Deep BO & Deep BOO
Hacking dengan MenggunakanHacking dengan Menggunakan

Walaupun sudah banyak dikenal orang dan juga dikenali oleh berbagai anti-virus, trojan Back Orifice tetap
menarik untuk dipelajari. Eryanto Sitorus membahas Back Orifice dan Deep Back Orifice untuk

melengkapi bahasan serupa mengenai NetBus yang telah dimuat di NeoTek Agustus 2002.

J

• Gambar 1: Menentukan target yang akan di-hack. • Gambar 2: Memeriksa IP/host yang akan di-hack.



NeoTekno

September 2002 NeoTek 35

NeoTekno

34 NeoTek September 2002

(listening) teks yang diketik oleh orang
yang anda hack. Agar perintah terse-
but bisa anda gunakan, maka anda ha-
rus mengetikkan sebuah nama file se-
bagai parameter untuk perintah terse-
but ke dalam field LLoogg  ffiilleennaammee, ke-
mudian klik tombol SSEENNDD. Dan jika
anda ingin melihat isi dari file tersebut,
pilihlah perintah File view, lalu klik
tombol SEND, namun sebelumnya
pastikan bahwa anda sudah memasuk-
kan nama file yang akan anda baca se-
bagai parameter untuk perintah terse-
but ke dalam field FFiilleennaammee.

Cara yang sama juga berlaku untuk
perintah MMMM  CCaappttuurree  ssccrreeeenn atau
yang lainnya, anda harus menentukan
nama file beserta ekstensi sebagai pa-
rameter terhadap apa yang akan anda
capture, ekstensi untuk file tersebut
misalnya GIF, JPG, BMP, atau yang
lainnya. Setelah proses caputure sele-
sai dan anda ingin melihat hasilnya,
carilah file tersebut dalam direktori
C:\TEMP, atau C:\WINDOWS\TEMP
di hard disk PC anda. Jika anda kesu-
litan menemukan file tersebut, man-
faatkan fasilitas Find → Files or Fold-
ers dari menu Start. Demikian sete-
rusnya, dan untuk mengetahui fung-
si-fungsi perintah yang lain selain pe-
rintah yang sudah saya jelaskan, sila-
kan anda mencobanya sendiri. Saya
yakin itu akan jauh lebih bermanfaat
daripada anda berlama-lama membaca
artikel ini.

Memulai Hacking dengan Deep
Back Orifice

Berikut adalah petunjuk untuk meng-
operasikan aplikasi Deep Back Orifice:

1. Masuklah ke dalam folder tempat
di mana anda menyimpan program apli-
kasi Deep Back Orifice, lalu klik file
DeepBO.exe. Sesaat kemudian akan
muncul pesan seperti yang tampak
pada Gambar 8. Jika IP yang muncul
di komputer anda tidak sama seperti
yang terlihat pada di bawah ini, abai-
kan saja, karena itu bukan merupakan
suatu masalah, lalu lanjutkan dengan
mengklik tombol OK.

2. Masukkan IP atau host orang yang
akan anda remote ke dalam field Quck
Connect to IP, lalu klik tombol Connect.
Dan sebagai petunjuk apakah IP atau
host yang anda masukkan tadi dapat di-
remote, periksalah jendela tab Explorer.
Jika jendela tersebut benar-benar kosong,
maka itu berarti aplikasi Deep Back
Orifice gagal menemukan program

BOSERVE.EXE. Tapi jika pada jendela
tab Explorer aplikasi Deep Back Orifice
anda terlihat informasi seperti pada
Gambar 9, maka sekali lagi saya ucap-
kan selama karena anda berhasil me-
nemukan IP atau host yang bisa anda
remote (hack).

3. Untuk melanjutkan proses hacking,
kliklah satu per satu tab (fitur) seba-
gaimana yang terlihat pada Gambar 9,
misalnya tab Keyboard untuk me-listen
teks yang diketik pada PC yang anda
remote, tab Screen untuk meng-capture

layar, tab Network untuk melihat in-
formasi jaringan, tab System Info
untuk melihat informasi spesifikasi
PC termasuk untuk mendapatkan
password yang terdapat pada PC ter-
sebut, tab Task untuk melihat infor-
masi program yang sedang aktif, tab
Remote, dan sebagainya.

ery@postmater.co.uk

• Gambar 7: Perintah-perintah Back Orifice
tanpa parameter.

• Gambar 8: Tahap awal menjalankan aplikasi
Deep Back Orifice.

• Gambar 9: Informasi yang menyiratkan
bahwa proses hacking berhasil.

• Gambar 12: Contoh informasi spesifikasi PC
dan password yang berhasil di-cache.

• Gambar 10: Contoh tampilan teks yang
berhasil di-listen.

• Gambar 13: Menjalankan program
menggunakan fungsi remote.

• Gambar 14: Contoh informasi program-
program yang sedang aktif.

• Gambar 11: Contoh tampilan informasi
network yang berhasil dideteksi.

seseorang, maka sangat kecil kemungkinan program
tersebut dihapus, dinonaktifkan, atau dideteksi oleh anti
virus, penyebabnya karena memang BOSERVE.EXE sudah
tidak dapat lagi ditemukan dalam hard disk. Pada saat
program tersebut aktif, maka secara otomatis dia langsung
berubah menjadi sesuatu yang misterius dan tidak berwu-
jud. Berbeda dengan PATCH.EXE milik NetBus yang bisa
dilihat atau dideteksi oleh anti virus, dan jika pemilik PC
yang anda hacking berhasil menemukannya dalam direk-
tori C:\WINDOWS dan menghapusnya, maka saat itu juga
anda akan kehilangan akses. (Inilah salah satu kelemahan
NetBus).

Sebelum kita mulai membahas bagaimana cara mengope-
rasikan kedua aplikasi itu, sebaiknya anda men-download-
nya lebih dahulu dari alamat berikut ini:
• www.cultdeadcow.com
• www16.brinkster.com/erytricksy/Software/bo120.zip
• www16.brinkster.com/erytricksy/Software/deep_bo.zip

Memulai Hacking dengan Back Orifice
1. Masuklah ke dalam folder di mana anda meletakkan
aplikasi Back Orifice, lalu klik BOGUI.EXE.

2. Kemudian masukkan IP atau host orang yang akan anda
remote ke dalam field TTaarrggeett  hhoosstt::ppoorrtt.

3. Untuk memastikan apakah IP atau host tersebut bisa
anda remote, maka anda harus memeriksanya terlebih
dahulu. Caranya, pilih PPiinngg  hhoosstt pada form Scrolling Text

Box, lalu klik tombol SSEENNDD. Kemudian perhatikan pesan
yang muncul setelah itu, jika anda hanya memperoleh
pesan seperti yang terlihat di bawah ini:

****  00::PPiinngg  hhoosstt  ppaacckkeett  sseenntt  ((1199  bbyytteess))  vvaall11::  ""  vvaall22::  ""

Artinya aplikasi Back Orifice anda gagal mendeteksi pro-
gram BOSERVE.EXE pada IP atau host tersebut. Namun
jika Back Orifice anda melaporkan hasil seperti yang
terlihat pada Gambar 2, saya ucapkan selamat! Itu artinya
anda telah berhasil menemukan IP atau host yang bisa
anda remote. Selanjutnya terserah anda. Pada form Scrol-
ling Text Box, selain Ping host, tersedia 51 perintah hack-
ing untuk anda gunakan. Sebagai contoh, anda ingin agar
PC yang anda hack tidak bisa mengakses situs Web, maka
anda tinggal memilih perintah HHTTTTPP  DDiissaabbllee,, lalu klik
tombol SSEENNDD. Untuk mengaktifkannya kembali, pilih
perintah HHTTTTPP  EEnnaabbllee, lalu klik tombol SSEENNDD. Jika anda
ingin mengetahui informasi spesifikasi PC yang anda hack,
pilih perintah SSyysstteemm  iinnffoo, lalu klik tombol SEND, bentuk
laporannya akan tampak seperti pada Gambar 3.

Namun anda juga harus teliti, karena tidak semua perintah
Back Orifice bersifat toggle (disable/enable), beberapa pe-
rintah lain membutuhkan parameter agar bisa bekerja.
Tetapi sebagai petunjuk bagi anda untuk mengetahui kapan
saatnya sebuah perintah bersifat toggle atau yang memer-
lukan parameter, maka anda cukup melihat pesan tampilan
yang berada tepat di bawah field TTaarrggeett  hhoosstt::ppoorrtt. Sebagai
contoh, misalnya anda ingin menggunakan perintah KKeeyy--
lloogg  bbeeggiinn, yaitu perintah yang berfungsi untuk mengintip

• Gambar 3: Melihat spesifikasi komputer.

• Gambar 4: Membuat parameter untuk perintah keylog begin.

• Gambar 5: Membaca file log menggunakan perinrtah File View.

• Gambar 6: Menutup dan membuka port HTTP (home page).
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3 MEMILIH NOMOR PORT
Masukkan nilai port yang diingin-
kan. Untuk kompatibilitas penuh
sebaiknya gunakan port di atas
1024, untuk memastikan tidak ada
konflik dengan port-port yang
sudah digunakan. Klik Next.

NeoTeknoNeoTekno

ack Orifice (BO), dikenal sebagai
remote win 9x administration
tool. Back Orifice dirilis pada

musim panas tahun 1998 pada saat Black
Hat security convention.

BO nyaris merupakan tools komplit da-
lam me-remote sistem Windows 9x, an-
tara lain: menambah/menghapus nilai
registry, reboot sistem, mengirim dan
menerima file, melihat pasword yg ter-
cache, membuat proses, dan lain-lain.

Dalam jaringan lokal atau yang terhu-
bung ke internet, BO memberikan user
kekuasaan lebih pada sistem komputer
yang di seberang sana. Tools ini sangat
kecil, terintegrasi dan mudah dioperasi-
kan di berbagai sistem Windows.

BBAACCK OK ORRIIFFIICCE 2000E 2000
MMEENNGGKKOONNFFIIGGUURRAASSII
BBO2K SO2K SEERVRVEERR

BO2K SERVER CONFIGURATION
Anda akan mendapatkan jendela
konfigurasi BO2K Server Config-
uration. Di sini anda dapat meng-
ubah konfigurasi server lebih lanjut.
Bila menggunakan opsi-opsi
standar pada Wizard, anda tidak
harus mengkonfigurasi lebih lanjut.
Klik Open Server.

OPEN FILE BO2K
Akan tampil jendela dialog Open yang
langsung menuju direktori Back Ori-
fice 2000. Ada tiga file: bo2k.exe,
bo2kcfg.exe, dan bo2kgui.exe. Pilih
bo2k.exe dan klik tombol Open.
Perhatian: Jangan membuka
BO2K.exe dengan double-click,
sebab anda akan terinfeksi sendiri!

INSTALASION WIZARD BO2K
Selesai instalasi dan memilih launch
software, maka anda akan menda-
patkan layar BO2K Configuration
Wizard yang disebut Step 1 (atau
setelah menjalankan file bo2kcfg.exe).
Klik Next untuk masuk ke Step 2 di
atas. Anda diminta memilih BO
server file. Biarkan bo2k.exe

TCP ATAU UDP?
Anda dapat memilih networking
module TCP atau UDP. Bila tidak
yakin apa yang mesti dipilih, biar-
kan TCP sebab UDP sifatnya kurang
bisa diandalkan dibandingkan TCP.

1

7 8

2

MEMASUKKAN PLUG-INS
Pada B02K distribution standar tidak
terdapat plug-in. BO2K plugin ter-
dapat lengkap di CD NeoTek Vol.
II/1 Oktober 2001. Pada contoh
ini ekstrak BO Peep dari ke folder
C:\Program Files\Cult of the Dead
Cow\Back Orifice 2000

FOLDER BARU: BO PEEP
Buka folder yang BO Peep yang
baru terbentuk dan pilih file plug-
in yang berupa file .DLL. Dalam
contoh ini adalah file bo_peep.dll
yang merupakan BO2K Remote
Console Manager.

METODE ENKRIPSI
Ada dua metode enkripsi: XOR atau
3DES. XOR untuk komunikasi yang
tidak terlalu kritis, sedangkan 3DES
untuk komunikasi privat yang kuat
dan secure. 3DES hanya tersedia
untuk di US, jadi kita lanjutkan
dengan meng-klik Next.

PASSWORD
Masukkan password, lalu klik Next.
Password (atau passphrase) akan
diperlukan sewaktu anda terhu-
bung ke server. Bila menggunakan
enkripsi XOR, panjang password
minimal 4 karakter, sedangkan
pada 3DES minimal 14 karakter.
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Konfigurasi BO2K server yang akan dikirim ke komputer sasaran.

FLEKSIBILITAS KONFIGURASI
Tampak demikian banyaknya opsi
yang dapat dikonfigurasi. Konfig-
urasi TCP misalnya, yang secara
default beroperasi pada port 54320
dapat anda ubah menjadi port
berapa saja. Pelajari opsi-opsi yang
demikian banyak itu.

9

FINISH
Konfigurasi server selesai. Klik Finish.
Selanjutnya anda harus mengkonfi-
gurasi BO2K client dengan opsi yang
sama. Bila anda akan menghubungi
server dengan komputer yang anda
pakai ini, maka client akan secara
otomatis di-setup sewaktu meng-
klik ‘Finish.’

6

NILAI DEFAULT FOLDER
Kita bisa mengubah default nilai
dalam folder yang tertera, sesuai
keinginan dan tujuan. Pada con-
toh ini tidak gunakan saja dulu
nilai default-nya. Klik Save Server
dan konfigurasi BO2K server
selesai.

12

Sekali BO menginfeksi sistem, dia tidak
akan tampil dalam list process (CTRL-
ALT-DEL), dan akan berjalan secara oto-
matis setiap kali komputer dijalankan.
Nama file yang berjalan sesuai dengan
yang kita tentukan sebelumnya pada
BOServer.

Pada kenyataannya, BO membuka jalan
kepada para hacker, jika tidak mengeks-
ploitasi setidaknya melakukan 'pelang-
garan.'

Pada rilis ke-2 BO, Back Orrifice 2000
(BO2K) terdapat beberapa peningkatan.
BO2K mempunyai semua kapabilitas
dari versi rilis yang pertama, dengan
beberapa perkecualian; server dan client

yang berjalan di NT/2000 dan Unix;
tersedianya developer kit.

Konfigurasi dasar BO2K berpatokan pada
TCP port 54320 atau UDP 54321, dan
mengkopi dirinya jadi umgr32.exe da-
lam folder system, menyamarkan dalam
task list sebagai EXPLORER dan meme-
rintahkan untuk mematikan sistem.

Jika disebar dengan Stealth Mode, maka
akan terinstal dalam entry HKLM\
SOFTWARE\Microsoft\Windows\
CurrentVersion\ RunServices yang
akan secara otomatis jalan pada Startup
dan menghapus file yang asli. Semua
setting ini dapat diatur menggunakan
bo2kcfg.exe.

Apabila ada pertanyaan mengenai
artikel ini, penulis dapat dihubungi di
wiz_wuz@telkom.net

B

Keberhasilan Back Orifice memotivasi anggota Cult of the Dead
Cow lain untuk menyempurnakannya menjadi Back Orifice 2000
(BO2K). Kelebihan BO2K adalah sifatnya yang dapat dikonfigurasi
sepenuhnya. Diovan membahasnya untuk anda.
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3 BO2K WORK SPACE
Beginilah bentuk BO2K wok space.
Pada ruang kerja inilah kita akan
mengendalikan remote computer
yang telah kita jadikan BO2K Server.
Kita akan mencoba menghubungi
komputer yang telah kita pasang-
kan BO2K.EXE tadi. Pilih menu File
> New Server.
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ungsi-fungsi standar yang ada
pada BO2K sudah begitu kaya,
sehingga akan mengasyikkan

anda mengeksplorasinya.

Menjalankan BO2K pada mesin sasaran
caranya mudah saja. Cukup meng-copy-
kan file bo2k.exe dan jalankan software
ini (dapat dengan double click, dan ingat
jangan sekali-kali lakukan itu di komputer
anda sendiri) maka secara otomatis file
ini akan meng-copy dirinya sendiri men-
jadi umgr32.exe ke Windows\System.
Nama ini dapat anda ganti sewaktu
konfigurasi server.

Setelah itu anda tinggal menjalankan saja
BO2K client yang akan menjadi pengen-
dali terhadap remote computer yang

BBAACCK OK ORRIIFFIICCE 2000E 2000
MMEENNJJALALANANKKAN PAN PADADAA
MMEESSIIN TN TARARGGEET DT DANAN
MMEENNGGEENNDDALIALIKKANANNNYYAA

MENGIRIM PERINTAH KE SERVER
Dari pilihan-pilihan command yang
ada, anda tinggal pilih lalu klik tom-
bol Send Command dan respons
dari server akan terlihat pada
windows pane bawah. Kita mulai
dengan dua Simple command:
ping dan query seperti tampak
pada gambar di atas.

MENCURI CACHED PASSWORD
Anda bisa mencuri cached password
dengan perintah List Passwords
pada System. Perintah pada System
lainnya sudah cukup jelas: Reboot
Machine, Lock-up Machine, dan Get
System Info. Anda coba saja sendiri
ketiga perintah ‘iseng’ ini.

MENJALANKAN BO2K
Copy BO2K.EXE ke mesin sasaran
dan double-click, BO2K Server akan
berjalan di latar belakang. Pada
contoh ini dipasang pada mesin
lain pada LAN (untuk mesin lain
di Internet, anda harus menjebak
pemakainya agar mau menjalan-
kan BO2K.EXE ini).

JALANKAN BO2K CLIENT
Dari Start > BO2K jalankan BO2K
Client. Akan tampil layar BO2K
Workspace yang diawali oleh logo
BO2K: ‘Show Some Control.’
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MELIHAT HASIL KEYLOGGING
Pada komputer target seseorang
membuka Microsoft Word dan
mengetikkan suatu teks dan
menyimpannya. Semua itu dapat
terlihat dengan jelas dengan View
Keystroke Log dan klik Send
Command.

MENGIRIM PESAN
Anda dapat mengirim pesan ke
komputer sasaran dengan
memilih GUI > System Message
Box dan ketikkan pesannya, lalu
klik Send Command. Pesan itu
akan tampil di komputer sasaran.

EDIT SERVER SETTING
Akan tampil jendela dialog Edit
Server Setting. Namakan server ini
(pada contoh: Compaq Hedhi) dan
server address-nya (dalam hal ini
192.168.123.148). Adapun connection
type, default encryption, dan auth-
entication sudah ditetapkan sewaktu
konfigurasi sebelumnya. Klik OK.

SERVER COMMAND CLIENT
Akan tampil jendela dialog Server
Command Client. Dari sini kita
dapat mengirimkan perintah-
perintah ke server. Untuk dapat
mengirimkan perintah, anda harus
terhubung dulu ke server tersebut.
Klik tombol Click to Connect.
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Mengendalikan remote computer yang dijadikan BO2K server.

KEYSTROKE LOGGING
BO2K dapat juga berfungsi sebagai
keylogger. Tetapkan nama file untuk
menampung keystroke ini, misalkan
nama file itu log. Pilih Log Keystroke
pada Key Logging dan klik tombol
Send Command. Tampak informasi
Key logging started. Pada komputer
target file log segera terbentuk.

9

TERHUBUNG!
Akan tampil jendela dialog Server
Command Client. Klik tombol
Connect dan server yang kita
hubungi memberi respons yang
ditunjukkan pada window pane
bagian bawah. Terlihat bahwa server
menginformasikan bahwa di mesin
ini terpasang BO2K versi 1.1.

6

PERINTAH-PERINTAH LAIN
Masih banyak perintah-perintah
lain yang menarik yang dapat
anda coba sendiri yang berhu-
bungan dengan TCP/IP, M$ Net-
working, Process Control, Multi-
media, File/Directory, Compress-
ion, DNS, Server Control, dan
Legacy Backup.

12

telah terpasang BO2K server. Untuk itu
anda harus terhubung dulu ke server
itu dengan menetapkan IP Address dan
port untuk koneksi. Nomor port ini di-
tetapkan sewaktu konfigurasi server.

Sekali BO menginfeksi sistem, dia tidak
akan tampil dalam list process (CTRL-
ALT-DEL), dan akan berjalan secara oto-
matis setiap kali komputer dijalankan.
Nama file yang berjalan sesuai dengan
yang kita tentukan sebelumnya pada
BOServer.

Dengan sekali klik pada tombol ‘Connect
to Server’ anda sudah dapat mengen-
dalikan remote computer itu sepenuh-
nya, termasuk me-restart komputer itu.

Selain fungsi-fungsi standar, BO2K
dapat dibuat lebi tangguh lagi dengan
menambahkan plug-in.

Berikut ini beberapa plug-in yang
tersedia untuk BO2K:

BO_Peep Plugin
Memungkinkan anda mengintip apa
saja yang sedang dikerjakan pada
komputer sasaran dengan sistem real-
time streaming video!

Butt Trumpet 2000
Remote e-mail tool

Rattler v.1.0
BO2K plug-in yang mengirim email
ke user tertentu walaupun IP address-
nya berubah

STCPIO Stealthy TCP IO
Plugin ‘asli’ dari Cult of the Dead Cow
untuk menghindari IDS

Cast-256 Encryption Plugin
Enkripsi yang lebih kuat (256 bit) dari
3DES (168 bit) maupun IDEA (128
bit)

Serpent Strong Encryption
Sekuat Cast-256 tetapi lebih cepat.

BOTool
Remote Filesystem Browser &
Registry Editor

F

Sekali BO2K server telah dieksekusi pada suatu komputer, maka
BO2K Server akan dijalankan setiap kali komputer tersebut
dijalankan, dan menjadi sasaran empuk BO2K Client.
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3 SETTING BO-PEEP
Catat setting BO Peep. Di antaranya: 
VidStream X Res: 160
VidStream Y Res: 120
VidStream Net Module: TCPIO
VidStream Bid Str: 15151
VidStream Encryption: XOR
VidStream Auth: NULLAUTH
Semua ini parameter video streaming.
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da banyak plugin untuk BO2K,
termasuk plugin untuk anonym-
ous email, menghindari Intrusion

Detection System (IDS), enkripsi, serta
remote registry editor.

Kali ini kita membahas BO2K plugin
yang paling standar, yaitu BO Peep. Wa-
laupun standar, plugin ini merupakan
yang paling menarik. Bagaimana tidak,
kita seolah-olah memasang televisi un-
tuk memonitor apa saja yang dikerjakan
remote computer, lewat layar dengan
video streaming!

Untuk menjalankan itu, baik pada BO2K
server yang kita kirim ke komputer sa-
saran maupun BO2K client yang kita
gunakan, harus terpasang BO Peep

BBAACCK OK ORRIIFFIICCE 2000E 2000
IINNSSTTALALAASSI BI BO PO PEEEEPP
DDAN MAN MEENNGGIINNTTIIPP
SSEECCARARA RA REEAL-AL-TTIIMMEE

PERINTAH BO PEEP KE SERVER
Jalankan VidStream dengan parameter-
parameternya. Pilih Start VidStream
pada folder BO Peep, lalu masukkan
FPS: 8
[XRes][,YRes][,NET][,ENC][,AUTH: 160,120
[Bind To]: 15151
lalu klik tombol Send Command

VISTREAM DIJALANKAN
Pada windows pane bawah
terlihat pesan bahwa VidStream
sudah dijalankan:
VidStream started on 192.168.123.148:15151

KONFIGURASI BO2K CLIENT
Jalankan bo2kgui.exe untuk
mendapatkan BO2K Workspace.
Pilih menu Plugins > Configure...
untuk menampilkan jendela
dialog Plugin Configuration.

APAKAH BO_PEEP TERPASANG?
Pastikan bahwa plug-in BO_PEEP
telah terpasang. Apabila komputer
yang anda gunakan ini adalah kom-
puter yang sama dengan yang di-
gunakan untuk mengkonfigurasi
plug-in untuk BO2K server, maka
konfigurasi client-nya akan sama.
Pilih folder BO Peep (warna biru).

1
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VIDSTREAM CLIENT SCREEN
Akan tampil layar biru dengan
ukuran 160×120 pixel yang akan
menjadi jendela kita untuk meng-
intip apa yang ditampilkan pada
layar remote computer (yang men-
jalanan BO2K server) dan sedang
kita kendalikan dengan BO2K
Client.

KE VIDSTREAM SERVER
Klik Connect pada tombol di bawah
layar dan anda akan masuk ke jen-
dela dialog Connect to. Pada server
address telah tertera nomor port
15151. Lengkapi dengan IP Address
menjadi 192.168.123.148:15151
dan klik OK.

PARAMETER UNTUK HIJACK
Parameter untuk meng-hijak remote
computer terdapat pada:
Hijack Net Module: TCPIO
Hijack Bind Str: 14141
Hijack Encryption: XOR
Hijack Auth: NULLAUTH
Klik Done untuk kembali ke BO2K
Workspace.

CONNECT TO SERVER
Pilih File > New Server dan ma-
sukkan setting dari server yang
akan dihubungi. Beri nama untuk
server ini dan masukkan IP
Address-nya. Klik OK untuk
menghubungi server tersebut.
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Memonitor secara real time apa yang dikerjakan dengan teknik  video stream.

JALANKAN VIDSTREAM CLIENT
Untuk menjalankan VidStream Client,
pilih menu Plugin > BO Peep >
VidStream Client dari BO2K
Workspace.

9

TERHUBUNG!
Akan tampil jendela dialog Server
Command Client. Klik tombol
Connect dan server yang kita
hubungi memberi respons yang
ditunjukkan pada window pane
bagian bawah. Terlihat bahwa server
menginformasikan bahwa di mesin
ini terpasang BO2K versi 1.1.

6

MONITOR REAL TIME
Segera akan tampil potongan
yang penting-penting dari layar
monitor remote computer seperti
bagian Taskbar yang di-klik serta
sebagian dari apa yang terlihat
pada desktop. Kebetulan di sini
remote computer sedang masuk
ke situs NeoTek.

12

plugin dengan konfigurasi yang sama.
Apabila anda menggunakan komputer
yang sama untuk client dan yang dipakai
untuk menyiapkan BO2K server, maka
konfigurasinya sudah sama, termasuk
konfigurasi plugin-nya.

Apabila BO2K server terhubung pada
port yang kita tetapkan sebelumnya
(dalam contoh pada port 54320), maka
Video Streaming ini akan terhubung
secara default ke port 15151 pada IP
Address yang sama.

Selain Video Streaming, terdapat pula
fungsi untuk meng-Hijak remote mouse
dari rwemote computer pada port 14141
di IP Address yang sama.

A

Big brother is watching you! Itulah kira-kira yang terjadi pada kom-
puter yang telah terinfeksi Back Orifice 2000 Server. Tanpa disadari,
apa yang dilakukan di komputer itu dapat diamati orang lain. • Tampilan layar BO2K client yang sedang memonitor apa yang dikerjakan BO2k server.



NeoTekno

September 2002 NeoTek 43

mudian klik “Version Information”
untuk memilih versi trojan yang
nantinya akan dideteksi NetBuster
ketika penyusup mencoba masuk ke
dalam komputer anda, seperti yang
tampak pada Gambar 2.

3. Mungkin, katakanlah ketika seorang
penyusup berhasil masuk ke dalam
komputer anda melalui program Net-
Bus, NetHacker, Back Orifice, atau
yang lainnya, maka orang tersebut
tentunya pasti ingin mengetahui in-
formasi versi trojan yang aktif di sis-
tem komputer anda, termasuk infor-
masi semua program yang sedang
anda aktifkan. Nah, khusus untuk
yang satu itu, kita bisa mengelabui
mereka dengan memberikan infor-
masi palsu. Caranya, masuklah ke tab
Messages, lalu ketikkan beberapa
informasi palsu ke dalam tab Info
Message, Normal Message dan tab
Windows, seperti yang terlihat pada
Gambar 3-4.

4. Setelah anda selesai mengisi infor-
masi atau keterangan palsu ke dalam
semua tab Messages, kemudian sim-
pan lah semua perubahan tersebut
dengan mengklik tombol Save, kemu-
dian klik Minimize. Demi keamanan
dan kenyamanan anda ketika berse-
lancar atau chatting di Internet, saya
sarankan sebaiknya biarkanlah pro-
gram tersebut selalu aktif di komputer

anda. Dengan begitu maka anda akan
selalu siap menjebak dan memper-
mainkan para penyusup (intruder)
jika sewaktu-waktu mereka mencoba
mengusik kenyamanan anda.

5. Setelah melakukan dialup, masuklah
ke dalam beberapa channel IRC yang
anda anggap sebagai channel “rawan”
hacker, dimana semua para peserta
yang ada di dalam channel-channel
tersebut berpotensi untuk melakukan
intrusi ke komputer orang lain. Dan
jika anda sedang bernasib baik, tidak
lama setelah itu program NetBuster
anda yang tadinya mungkin sedang
“tidur,” tiba-tiba “terbangun” dan
melaporkan sinyal bahaya kepada
anda, seperti terlihat pada Gambar 6.

Dalam Gambar 6 terlihat bahwa se-
orang penyusup yang menggunakan
alamat IP 202.159.28.171 sudah ber-
hasil masuk ke dalam perangkap an-
da. Tapi sayangnya nasib baik anda
ternyata nilainya tidak mencapai
100%, mungkin hanya 50% saja.
Karena pada jendela Logged events
and actions terbaca pesan “No Net-
Bus server found on remote host.”
Artinya anda tidak bisa menyerang
penyusup tersebut secara total. Na-
mun demikian anda masih bisa
“menggertak” penyusup tersebut de-
ngan mengirim pesan seperti yang
terlihat pada Gambar 7 melalui tom-
bol “Send Message(s).” Dan jika anda
tidak terlalu mood untuk memper-
mainkan penyusup itu, segera putus-
kan koneksinya dengan mengklik
tombol Disconnect.

Setelah memutuskan koneksi si penyu-
sup tadi yang kehadirannya tidak be-
gitu membuat kita surprise, mungkin
tidak lama setelah itu NetBuster anda
kembali melaporkan sinyal bahaya,
seperti terlihat pada Gambar 8.

Apa yang dilaporkan NetBuster
seperti terlihat dalam Gambar 8
tentunya adalah merupakan "good
news" buat kita. Kerena dengan
begitu, maka apa yang kita harapkan
sejak awal kini sudah terkabul.
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IKA ANDA TERMASUK SALAH sa-
tu dari sekian banyak peng-
guna Internet, yang (mungkin)

pernah di-”terror” hacker, tentunya
anda pernah memikirkan bagaimana
cara menjebak dan mempermainkan
mereka biar kapok! Bagi saya pribadi,
yang pernah dikerjai mereka, itulah
salah satu yang menjadi obsesi setiap
kali akan terhubung ke Internet. Ya!
saya ingin balas dendam.

Kejadiannya persis terjadi kira-kira
dua bulan yang lalu, ketika saya
sedang asyik chatting pada salah satu
channel IRC (Internet Relay Chat).
Tidak tahu dari mana sumbernya dan
apa penyebabnya, tiba-tiba dua buah
program yang sedang saya jalankan
saat itu (mIRC dan Internet Explorer)
lenyap begitu saja dari pandangan
mata, dan disusul kemudian dengan
Shut Down. Pada awalnya saya cuma
mengira bahwa penyebabnya adalah
karena operating system Microsoft
Windows ME (Millennium Edition)
saya yang sedang “kacau,” namun
setelah beberapa kali saya mengetik
ulang kata sandi (password) email
dan nick IRC, yang muncul selalu
tulisan “Invalid Password” — “Incor-
rect Password.” Akhirnya saya baru
sadar bahwa kejadian tersebut tadi
bukan karena kerusakan pada sistem,
tetapi lebih tepat disebut “malapeta-
ka,” karena saya benar-benar telah
di-hack seseorang yang tidak tahu
siapa orangnya dan di mana dia berada.

Dengan perasaan dongkol dan geram,
kemudian saya periksa komputer saya
dan melakukan uji coba. Ketemu!
Rupanya selama ini, tanpa saya sadari,
komputer saya telah berubah menjadi
“server” bagi seseorang yang berhasil
memasukkan dan mengaktifkan
PATCH.EXE ke dalam sistem saya.
PATCH.EXE adalah file trojan milik
program NetBus, yang jika dia aktif
atau diaktifkan ke dalam komputer
seseorang, maka secara otomatis kita
akan dengan mudah masuk dan me-
lakukan apa saja di komputer orang

tersebut, termasuk melihat kata sandi
(password), meng-kill (close) program
yang sedang aktif dan men-shut down
komputernya melalui program yang
disebut NetBus, NetHacker, Back Ori-
fice atau Deep Back Orifice. Itulah satu
kesimpulan yang saya peroleh. Oleh
karena itu, saya juga ingin menginga-
tkan anda, agar waspada dan selalu
berhati-hati pada saat terhubung ke
Internet. Karena di Internet tidak ada
yang tidak mungkin.

Nah, sekarang kita kembali ke perso-
alan semula, yaitu bagaimana cara
menjebak dan mempermainkan me-
reka yang mendeklarasikan dirinya
sebagai hacker, yang kerjanya sehari-
hari mungkin hanya ingin menginti-
midasi dan mempermainkan anda,
saya, dan pengguna Internet lain.

Salah satu cara yang paling gampang
untuk melakukan hal itu adalah de-
ngan menggunakan program
NetBuster, yang dibuat oleh Hakan
Bergstrom. Program tersebut bisa an-
da peroleh gratis di alamat berikut:

• http://surf.to/netbuster
• www16.brinkster.com/erytricksy

/Software/ netbuster_v131.zip

Secara teknis, NetBuster adalah pro-
gram anti NetBus, yang selain ber-
fungsi untuk mempermainkan para
penyusup yang masuk ke dalam kom-
puter kita, juga dimungkinkan untuk
melakukan serangan balik ke kompu-
ter orang tersebut. Bisa melalui pro-
gram NetBuster itu sendiri atau pro-
gram hacking lain seperti NetHacker,
Back Orifice, Deep Back Orifice, dan
sebagainya. README file menyebut-
kan “NetBuster is Win 95/97/98/ME
/2000/XP/NT tool to fool with the
people trying to fool you with NetBus.
It also removes any NetBus server
from your system if found. NetBuster
emulates the NetBus server so that
the intruder THINKS he's fooling
around with you. But instead all his
actions will be logged, and you will
be able to fool him instead.”

Nah, setelah anda membaca deskripsi
singkat cara kerja NetBuster (secara
teori), maka sekarang kita akan mem-
praktikkannya secara langsung. Perlu
anda ketahui, bahwa semua proses
yang diperlihatkan pada beberapa
gambar yang penulis sertakan dalam
artikel ini, adalah gambar dari keja-
dian “nyata” yang penulis tangkap
pada saat seseorang masuk ke dalam
komputer penulis. Langkah-langkah-
nya adalah sebagai berikut:

1. Pertama masuk ke folder atau direk-
tori tempat anda meletakkan program
NetBuster, lalu klik dua kali file NET-
BUSTER.EXE. Sesaat kemudian Net-
Buster akan memeriksa apakah Net-
Bus server sedang aktif di memori
komputer anda, seperti terlihat pada
Gambar 1. Jika NetBuster menemu-
kannya, maka NetBuster akan me-
nonaktifkan dan menghapusnya.

Sebagai informasi, setelah anda meng-
instal NetBuster, program tersebut
akan dijalankan secara otomatis se-
tiap kali anda meng-ON kan kompu-
ter anda. Namun jika anda tidak
menginginkan itu terjadi, anda bisa
mengubahnya dengan menghilang-
kan opsi [√] pada Make NetBuster
autostart dalam tab Various.

2. Klik tab Various, lalu pastikan bahwa
anda sudah mengaktifkan opsi “Check
if intruder has trojan installed.” Ke-

NetBusterNetBuster
Menjebak PMenjebak Parara Pa Penyusupenyusup

Jengkel karena pernah di-hack? Jangan tinggal diam, gunakan NetBuster untuk menjebak para
penyusup seolah-olah sudah berhasil menguasai komputer anda, padahal andalah yang

menguasai komputer si iseng itu. Eryanto Sitorus membahasnya untuk anda.

J

• Gambar 1: Menjalankan program NetBuster.

• Gambar 3: Mengisi informasi palsu
ke dalam tab Info Message.

• Gambar 4: Mengisi informasi palsu
ke dalam tab Windows.

• Gambar 5: Tampilan ikon program
NetBuster yang sedang aktif.

• Gambar 2: Memilih versi Trojan
yang akan dideteksi.

• Gambar 6: NetBuster melaporkan
sinyal bahaya.

• Gambar 7: Mengirim pesan
kepada penyusup.

• Gambar 8: Sinyal bahaya yang 
ilaporkan NetBuster.



NTERNET ADALAH SESUATU YANG SANGAT FENOMENAL, DIA TUMBUH DAN
berkembang dengan cepat, dibutuhkan karena bermanfaat sebagai media
komunikasi dan sumber informasi, diminati dan digemari banyak orang

dari semua lapisan masyarakat, baik yang kaya, setengah kaya, laki-laki, perempuan,
tua, dan muda. Namun, tanpa kita sadari, ternyata Internet juga dapat membuat
kita menjadi boros, ketagihan, merasa curiga, gelisah, dan selalu khawatir, yang
pada akhirnya lama-kelamaan dapat merubah diri kita menjadi seorang paranoid.

Mungkin, salah satunya, hal itu lah yang dirasakan oleh rekan sekantor saya.
Akibat ketagihan "ngakses" Internet, dia kaget bukan main setelah membayar
rekening listrik dan telepon yang jumlahnya nyaris sama dengan jumlah gaji
yang diperolehnya di kantor.

Sementara itu, masalah-masalah lain yang juga kerap membuat kita gelisah ada-
lah kehadiran dan aktifitas para hacker, yang secara langsung maupun tidak lang-
sung berhasil membuat kita merasa khawatir dan menjadi tidak leluasa ketika
mengakses Internet. Kehadiran mereka di dunia Internet telah menjadi ancaman
besar buat kita (pengguna Internet). Akibatnya, kita pun menjadi merasa tidak
aman setiap kali mengetik kata sandi (password) email, kita curiga jangan-jangan
ada pihak lain menangkap apa yang kita ketik pada saat akan meng-indentify
nick IRC (Internet Relay Chat) ke NickServ, atau kata sandi channel IRC yang
sudah saatnya untuk kita indentify sebelum di drop oleh ChanServ. Kita juga
merasa khawatir ketika akan mengetik kata sandi shell account, account Web,
GuestBook, serta account-account lainnya. Jika itu yang terus menerus kita alami
setiap kali terhubung ke Internet, maka bukan tidak mungkin hal itu akan mem-
berikan implikasi buruk pada kesehatan kita.

Nah, daripada kesehatan kita terganggu karena selalu merasa khawatir, gelisah,
dan curiga tidak menentu seperti itu, lebih baik kita amankan sistem komputer
kita. Salah satu cara yang paling efektif yang dapat kita lakukan, tentunya adalah
dengan menginstal software yang benar-benar bisa diandalkan dan dapat diper-
caya untuk melindungi komputer dari serangan hacker. Dalam hal ini anda perlu
selektif, saya katakan sekali lagi pilihlah software yang keandalannya sudah
tidak diragukan lagi.
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Perhatikan, pada program NetBuster
anda tersedia tujuh tombol penting
yang kini sudah dapat anda pakai un-
tuk memukul balik si penyusup tadi,
yaitu: Open CD, Swap Mouse, Key
Click On, Set Password, Disconnect,
Send Message(s) dan Send Info(s).

Hal ini berbeda dengan apa yang
diperlihatkan pada Gambar 7, yang
hanya menyediakan tiga buah
tombol. Namun jika anda merasa
tidak cukup puas hanya menggertak
si penyusup tadi dengan mengirim
pesan-pesan “angker,” atau membuka
dan menutup CD ROM komputer-
nya. Anda bisa menjalankan program-
program hacking lain, seperti NetBus,
atau Back Orifice misalnya, yang me-
miliki banyak tombol-tombol penting
seperti yang tampak pada Gambar 9.

Akhirnya, sebagai penutup, saya
ucapkan selamat pada anda!. Karena
dengan mencoba menerapkan apa
yang sudah saya bahas dalam artikel
ini, maka secara langsung maupun
tidak langsung anda telah ikut ber-
partisipasi dalam memberantas
narkoba, Eeh maksud saya dalam
memberantas hacker. Good luck!

Apabila ada pertanyaan mengenai
artikel ini, hubungi penulisnya di
ery@postmaster.co.uk.

• Gambar 9: Menyerang si penyusup
dengan NetBus.

I
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Salah satu dari sekian banyak software yang layak untuk
anda pertimbangkan adalah BlackICE Defender. Alasan
penulis merekomendasikan software tersebut untuk anda
pakai adalah karena memang penulis telah membuktikan-
nya sendiri, BlackICE Defender adalah software anti hacker
yang terbaik dan sangat handal. Dengan BlackICE Defender,
maka dapat dipastikan bahwa komputer atau jaringan kom-
puter anda akan selamat dan terhindar dari hacker, yang
selain bermaksud ingin mengusik kenyamanan anda ketika
berselancar di Internet, juga ingin mencuri data, dan men-
celakakan komputer anda.

Disebutkan bahwa BlackICE terbuat dari alat pelacak yang
kekuatannya sangat luar biasa dan sekaligus sebagai mesin
analisis yang dapat memvisualisasikan semua lalu-lintas port

jaringan dan proto-
kol yang dicurigai.
Jika BlackICE men-
deteksi adanya ke-
mungkinan serang-
an, maka BlackICE
akan langsung me-
ngirim dan merekam
aktifitas tersebut ke dalam file log. Kemudian informasi ten-
tang penyerang tersebut akan dilaporkan ke dalam tab Intru-
ders, seperti yang terlihat pada Gambar 1. Sedangkan infor-
masi tetang jenis serangan yang dilakukan para penggangu
tersebut akan di coba divisualisasikan ke dalam tab Attacks,
seperti yang tampak pada Gambar 2.

BlackICE mengumpulkan informasi dari setiap serangan
yang sudah dianalisis dengan menggunakan algoritma ja-
ringan yang dibuat secara khusus. Jika serangan tersebut
nantinya dianggap berpotensi menjadi intrusi, maka BlackICE
akan secara otomatis memblok setiap akses yang dilakukan
dari komputer (alamat IP) hacker tersebut. Dan asal anda
tahu saja, biar bagaimana gigihnya pun hacker tersebut men-
coba meng-crack sistem anda, dijamin orang tersebut tidak
akan pernah berhasil masuk ke dalam lingkungan BlackICE.

Secara teknis, BlackICE dapat bekerja dengan baik pada
sistem operasi Microsoft Windows 95/97/98/ME/2000/
XP serta Windows NT. Sedangkan spesifikasi hardware
yang dibutuhkannya, antara lain adalah:

1. Menggunakan prosesor Pentium.
2. Sedikitnya memiliki RAM sebesar 16 MB.
3. Kapasitas hard disk yang tersisa sedikitnya harus ada

sebesar 6.5 MB. Jumlah tersebut sudah termasuk
persiapan tempat sebesar 2.5 MB untuk
mengalokasikan semua file logging trace.

Jika anda tertarik untuk menginstal software tersebut,
anda dapat menginstalnya langsung dari dalam CD
Neotek yang disertakan pada majalah ini. Namun bagi
anda yang (mungkin) hanya meminjam majalah ini dari
teman anda (alias tidak membeli), anda bisa mendown-
loadnya dari beberapa alamat situs tersebut di bawah ini:

1. www.black-ice-firewall.com
2. www.lml.se/blackice.htm
3. www.aragoza.com/download/ blackice/defender/
4. www16.brinkster.net/erytricksy/ Software/
5. www.downloadstore.com/

ery@postmaster.co.uk

BlackIBlackICCE E 
PPelindung terhadap Netelindung terhadap Network Intrusionwork Intrusion

Untuk melengkapi tulisan mengenai Intrusion Detection System (IDS) sebelumnya (Snort dan Portsentry),
kali ini Eryanto Sitorus membahas salah satu

Intrusion Detection System yang mudah digunakan, yaitu Black ICE.

• Gambar 1: Informasi para pengguna (intruder).

• Gambar 2: Informasi jenis serangan yang dilakukan para pengganggu.

• Gambar 3: BlackICE
Defender yang sudah

terinstal dan aktif.
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3 BUAT AUTOEXEC.CFG
Buka Notepad dan tuliskan log on.
Kemudian Save as autoexec.cfg dan
simpan di folder C:\Sierra\Counter-
Strike\cstrike\. Kemudian mainkan
game Counter Strike dengan bot
anda agar terbentuk direktori logs
di folder cstrike. Semua kemenang-
an dan kekalahan akan dicatat.  

NeoGameNeoGame

ame Counter strike, merupakan
game FPS (First Person Shooter);
di sini pemain bertindak seolah-

olah dia sendirilah tokoh dalam permainan.

Game ini ternyata banyak digandrungi
orang dari berbagai belahan bumi. Kegan-
drungan akan game ini dapat dilihat dari
banyaknya support yang dibuat user (peng-
gemar game) Counter Strike seperti mi-
salnya peta untuk variasi permainan yang
dapat di-download gratis oleh user lain.

Tulisan ini mencoba mengulas psycho-
stats, salah satu support terhadap game
Counter Strike. Psychostats merupakan
utilities kreasi Stormtrooper dalam ben-
tuk Perl dan PHP, yang di sini psycho-
stats berfungsi mencatat status pemain

PSPSYYCCHHOOSSTTAATSTS
DDUUKKUUNNGGAN SAN STTAATTIISSTTIIKK
GGAMAME COE COUUNNTTEER-R-SSTTRRIIKKEE

LIHAT DENGAN BROWSER
Ketikkan http://localhost/cgi-bin/stats
untuk melihat status permainan anda.
Ada sesuatu yang mengganggu yaitu
adanya banner tanpa gambar di bagian
paling atas halaman. Ini karena file
gambarnya hanya tersedia online.
Yang harus dilakukan adalah rename
direktori Psychostats ke Psycho

MENGHILANGKAN BANNER
Hilangkan dengan menghapus banner
codenya. Masuk ke C:\Sierra\Psycho\
themes\cstrike1.7 atau cstrike1.7php
untuk membuka PHP theme dan cari
banner html. Buka dengan Notepad
dan hapus kode mulai tag <a> pertama
sampai <br>, kemudian Save. Jalankan
stats.pl. Banner pertama hilang.

MASUK KE SITUS PSYCHOSTATS
Arahkan browser anda ke alamat
http://www.psychostats.com/
download.php Pilih Windows  Distri-
bution versi 1.7 dengan ukuran
2MB file zip.

UNZIP FILE PSYCHOSTATS
Anggaplah anda telah memiliki
game Counter Strike yang diinstal
di folder C:\Sierra\Counter-Strike
(default). Unzip semua file psycho-
stats1.7.zip yang telah anda down-
load ke folder C:\Sierra. Jangan gu-
nakan Notepad untuk mengubah
setting, melainkan Wordpad.

1
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SETTING PHP.INI
Untuk menggunakan PHP Theme, set
php.ini. Buka dengan Notepad; cari dan
ubah setting barisnya. Cari display_error,
set ke Off dan tambahkan ; (titik koma)
ke error_reporting yang belum mempu-
nyai  ;PHP programmer harus mengem-
balikan settingnya ke semula. Jalankan
stats.pl, buka browser dan uji.

PLAYER LOGO
Untuk memakai player logo pada file
playerlogos.cfg perlu ditambahkan tag.
Tulis seperti seperti yang dicontohkan.
Boleh juga menghapus line Default
kalau anda bukan server admin di In-
ternet. Untuk mengotomatisasi peker-
jaan update status, bisa gunakan
Scheduled Wizard pada Windows.

UBAH SETTING STATS.CFG
Cari stats.cfg di direktori C:\Sierra\
psychostats kemudian buka file ter-
sebut dengan Wordpad. Cari baris:
LogPath dan ubah  persis menjadi
LogPath = C:\Sierra\Counter-Strike\
cstrike\logs. Kemudian Cari baris
HtmlPath dan ubah ke C:\Personal
Web Server\cgi-bin\stats

UBAH SETTING STATS.CFG
Kemudian carilah baris PicsPath
ubah ke C:\Personal Web Server\cgi-
bin\stats\images\mappics. Cari DLPath
ubah ke C:\Sierra\Counter-Strike\
cstrike\maps. Anda juga perlu me-
modifikasi baris tertentu seperti
Admin name, admin e-mail sesuai
data diri anda. Terakhir Save. 

4
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Instalasi support untuk game Counter Strike membutuhkan pengetahuan mengenai Perl and PHP.

PHP THEME
Psychostats dengan PHP theme lebih
unggul karena mempunyai fungsi
Search pemain (yang telah memenuhi
syarat kemenangan). Theme yang
tersedia terdiri dari 4 bagian, 2 bagian
untuk versi cstrike html dan 2 untuk
PHP. Versi html telah selesai dibahas.
Langkah selanjutnya untuk PHP theme.

9
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mengenai kemenangan, kekalahan, sen-
jata yang dipakai, sampai status peta
yang digunakan.

Pada awalnya, psychostats  berjalan pa-
da sistem operasi Linux, namun kini
psychostats berjalan juga pada Windows.

Script yang diciptakan Stormtrooper
masih memiliki kekurangan, terutama
kesalahan penggunaan variabel dalam
salah satu script PHP-nya. Namun ke-
kurangan tersebut bukanlah kesalahan
yang fatal dan masih dapat di atasi.

Konsep kerja psychostats sangat
sederhana. Psychostats dalam bentuk
script Perl berfungsi memproses kata-
kata yang dihasilkan oleh Server

Game Counter Strike yang kemudian
disajikan dalam bentuk diagram da-
lam Layout Table yang mudah dibaca
dan dipahami.

Agar dapat menggunakan Psychostats,
pada komputer yang merupakan
server Counter Strike terlebih dahulu
sudah harus terinstal Active Perl, PWS
(Personal Web Server), dan PHP.

Setelah ketiga pendukung tersebut
telah terinstal, selanjutnya tinggal
menginstal psychostat itu sendiri.

Untuk jelasnya, ikuti langkah-langkah
dalam artikel ini berikut ini.

Untuk mengetahui informasi lebih
dalam mengenai psychostats, kunjung-
i www.psychostats.com Di situs ter-
sebut terdapat forum bagi yang ingin
bertanya seputar psychostats.

Apabila ada petanyaan mengenai
artikel ini, penulis dapat dihubungi
di ascii255@telkom.net

G

Begitu populernya Counter Strike sebagai game First Person
Shooter yang dimainkan secara multiplayer di Internet memuncul-
kan banyak situs-situs pendukung bagi game ini. Selain pengayaan
seperti peta permainan, terdapat pula psychostats, dukungan
untuk statistik permainan. William menyajikannya untuk anda.

JALANKAN FILE INSTALASI
Sekarang jalankan file install.pl. Anda
akan ditanya apakah settingnya telah
benar, ketik Yes. Dengan begitu akan
terbentuk stats.pl dan folder images
di folder stats. Kemudian jalankan
stats.pl maka semua log file akan di-
scan dan terbentuk file html di PWS.
File stats.pl perlu dijalankan berulang
kali untuk mengupdate status permainan.
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5. Setelah selesai, simpanlah puzzle tersebut dengan meng-
klik “Save jigsaw.” Namun sebelum anda menyimpannya,
program akan meminta anda untuk membuat terlebih
dahulu deskripsi tentang puzzle yang baru saja anda
ciptakan tadi. Beberapa deskripsi yang dapat anda isi-
kan ke dalam puzzle tersebut antara lain adalah: Title,
Creator). Selain itu anda juga bisa memasukkan komen-
tar anda sendiri pada field “Description.” Setelah sele-
sai, klik tombol OK, lalu simpan file tersebut ke dalam
folder atau direktori yang anda inginkan.

6. Selamat! Puzzle sudah jadi. Untuk memainkan puzzle
tersebut, caranya adalah sebagai berikut:

• Klik menu File → Open. Kemudian pada jendela
Jigsaw Preview, pilih Jigsaws.

• Kemudian tentukan nama folder atau direktori tempat
anda menyimpan puzzle yang tadi anda buat. Beberapa
saat kemudian anda akan segera melihat gambar puzzle
yang siap untuk anda mainkan. Sebelum anda mengklik
tombol “Open,” pilihlah tingkat kesulitan yang sesuai
dengan keinginan anda. Misalnya, tingkat Default, Easy,
Medium, Hard, atau Custom, dan termasuk ukuran
potongan masing-masing gambar.

• Klik tombol “Open.” Nah, sekarang cobalah susun
potongan-potongan puzzle tersebut hingga menjadi
gambar utuh. Jika anda berhasil, anda akan menda-
pat ucapan selamat dari Jigsaws Galore.

Apabila ada pertanyaan mengenai artikel ini, penulis
dapat dihubungi di ery@postmaster.co.uk

• Memilih model potongan, tingkat kesulitan, dan ketakteraturan puzzle. • Puzzle yang siap untuk dimainkan.

Iklan visionnet
17,6 x 12,3

NeoGame

48 NeoTek September 2002

ETIAP HARI NONGKRONG DI DEPAN KOMPUTER ter-
kadang bisa membuat kita merasa sumpek, jenuh,
bosan, atau bete. Jika sudah bosan, maka akhir-

nya kita pun jadi bingung dan agak sedikit malas-malasan.
Bahkan, saking sumpeknya, kadang-kadang chatting saja
pun rasanya malas, mau browsing malas, 'nyetel MP3
malas, main game malas, sementara jelas-jelas kita tahu
bahwa saat itu (mungkin) PC kita masih dalam keadaan
terhubung (connected) ke Internet. Nah, dari pada kita
uring-uringan tidak karuan, dan menghabiskan pulsa te-
lepon untuk sesuatu yang tidak dinikmati, lebih baik kita
bermain puzzle, yah tentunya puzzle elektronik yang
dibuat dengan program dan dimainkan di komputer. Asyik!

Program yang akan kita gunakan untuk membuat puzzle
bernama Jigsaws Galore v4.2, yang diciptakan David P.
Gray tahun 1996. Jika anda berminat menggunakan pro-
gram tersebut, anda bisa menginstalnya langsung dari CD
NeoTek yang disertakan dalam majalah ini, atau men-
downloadnya dari:

• www.dgray.com
• www16.brinkster.com/erytricksy/Software/jigsaw_v42.zip

Proses Pembuatan Puzzle
Untuk membuat puzzle elektronik, yang pertama-tama
anda lakukan adalah menyediakan beberapa gambar, yang
tentunya menurut anda cukup menarik dan cocok dijadi-
kan puzzle. Namun jika stok gambar anda tidak begitu
lengkap atau menarik, program Jigsaws Galore juga me-
nyertakan beberapa gambar yang bisa anda pilih untuk
dijadikan puzzle. Adapun format file gambar yang didu-
kung oleh program Jigsaws Galore untuk dijadikan puzzle
antara lain adalah BMP, JPG, PCX, TGA, WMF, EMF.

Nah, setelah anda berhasil menemukan/mengumpulkan
gambar-gambar, maka sekarang kita akan membuatnya
sebagai puzzle. Proses pembuatannya sangat gampang,
caranya adalah sebagai berikut:

1. Jalankan program Jigsaws Galore.

2. Dari jendela Jigsaws Preview (File → Open), pada bagian
“File type,” pilih “Images.” Kemudian tentukan nama
folder atau direktori tempat anda akan menyimpan
file-file gambar anda.

3. Setelah gambar di-load ke dalam mode Preview, klik
tombol “Open,” sesaat kemudian akan muncul jendela
“Make a jigsaw.”

4. Pada jendela “Make a jigsaw,” pilih model atau bentuk
potongan gambar yang anda inginkan. Model atau ben-
tuk-bentuk potongan gambar yang bisa dipilih adalah:
Classic, Blip, Squares, Stars, Bubbless, dan Mixture.
Kemudian tentukan berapa banyak gambar yang akan
anda potong (cut). Banyaknya potongan gambar yang
diizinkan adalah berkisar antara 4 sampai 16 potong.
Dan setelah itu tentukanlah tingkat ketidakteraturan
(Oddness) potongan-potongan gambar tersebut. Ting-
kat ketidakteraturan gambar yang diizinkan untuk kita
set ialah mulai 0 hingga 10.

Puzzle ElektrPuzzle Elektronikonik
MembuatMembuat && BermainBermain

Karena rutinitas sehari-hari dalam berkomputer, anda mungkin memerlukan sesuatu yang bersifat
entertainment. Eryanto Sitorus mengajak anda berekreasi membuat game puzzle sendiri. dengan

menggunakan program gratis bernama Jigsaws Galore.

S

• Menentukan folder/direktori gambar.




